9681 Printer Controller

User's Manual

Welcome

Thank you for purchasing the printer controller. The printer controller is an image controller designed to use the machine as a printer. By connecting the printer controller to the machine, you can directly print documents created on your computer to the machine. In addition, the printer controller is capable of using various functions offered by the machine, such as N-in-1 and Booklet, enabling you to create a wide variety of documents.

This User’s Manual explains how to run print cycles on the machine, to which the printer controller is connected. It also gives precautions that you should review before attempting to actually use the printer controller. So, first read this manual carefully and thoroughly; then, keep it close at hand so you can refer to it whenever it becomes necessary.

When operating the printer controller and machine, follow the instructions given in this manual and in the one for the machine. Do not attempt to touch any part that is not covered in these manuals. Never attempt to disassemble or remodel any pieces of equipment, either, to prevent possible hazardous conditions.

Some of the screens shown in this manual may look different from what you will view in actual applications.

Trademark Acknowledgments

DEVELOP is a registered trademark of DEVELOP GmbH.
Microsoft, Windows 3.1, Windows 95, Windows NT 3.51 and Windows NT 4.0 are registered trademarks of Microsoft Corporation.
IBM and PC/AT are registered trademarks of International Business Machines Corporation.
PCL is a registered trademark of Hewlett-Packard Company.
TrueType is a registered trademark of Apple Computer, Inc.
All other products or brand names are trademarks or registered trademarks of their respective companies or organizations.
Adobe, Post Script and the Post Script logo are trademarks of Adobe Systems Incorporated.
CE Marking (Declaration of Conformity)

We declare under our sole responsibility that the copier and options to which this declaration relates is in conformity with the specifications below. This declaration is valid for the area of the European Union (EU) only.

<table>
<thead>
<tr>
<th>Product Type</th>
<th>Printer Controller</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product Name</td>
<td>Pi3500</td>
</tr>
<tr>
<td>Options</td>
<td>32MB Memory, 64MB Memory, Network Interface Card (4179-422, 4179-432), Hard Disk Drive (4179-462)</td>
</tr>
</tbody>
</table>
                     (Limits and method for measurement of radio disturbance characteristics of information technology equipment (ITE))  
                     EN61000-3-2 / 1995  
                     (Electromagnetic compatibility (EMC)-Part 3: Limits, Section 2: Limits for harmonic current emissions (equipment input current \(\geq 16A\) per phase))  
                     EN 50 082-1/1992  
                     (Electromagnetic compatibility-Generic immunity standard Part1: Residential, commercial and light industry)  
                     IEC 801-2 / 1991 (Electrostatic discharge requirement)  
                     IEC 801-3 / 1984 (Radiated electromagnetic field requirement)  
                     IEC 801-4 / 1988 (Electrical fast transient / burst requirement) |
| Notes          | This device must be used with shielded interface cables.  
                     EN 50 082-1 / 1992  
                     (Electromagnetic compatibility-Generic immunity standard Part1: Residential, commercial and light industry)  
                     IEC 801-2 / 1991 (Electrostatic discharge requirement)  
                     IEC 801-3 / 1984 (Radiated electromagnetic field requirement)  
                     IEC 801-4 / 1988 (Electrical fast transient / burst requirement) |
| EC Directives  | EMC : 89 / 336 / EEC and 93 / 68 / EEC |

This device must be used with shielded interface cables. The use of non-shielded cables is likely to result in interference with radio communications and is prohibited under EC Directive rules.

EC-01
Contents

Chapter 1  Before Using the Printer Controller

1. Features of the Printer Controller
   Features of the Printer Controller ........................................ p.1-2
   Administrative Functions ................................................ p.1-5
   About PCL5e and PCL6 .................................................. p.1-5

2. Configuration
   Configuration ............................................................... p.1-6

3. Connecting the Printer Controller
   Connecting the Printer Controller ..................................... p.1-7

4. Settings Made on the Machine
   Priority Device ............................................................ p.1-8
   On Line ........................................................................ p.1-8
   Test Print ...................................................................... p.1-8

5. Installing the Printer Drivers
   Installing Various Printer Drivers .................................. p.1-10

Chapter 2  Installing the Printer Driver

1. Windows 95
   Operating Environment ................................................ p.2-2
   Installation ..................................................................... p.2-3
   Test Print ...................................................................... p.2-9
   Making General Settings Before Using the Printer .......... p.2-10
   Displaying a Property Sheet ......................................... p.2-11
   Displaying a Property Sheet from the Printer Folder ...... p.2-11
   Displaying a Property Sheet from an Application Menu p.2-11
   "General" Property Sheet ............................................. p.2-13
   "Details" Property Sheet .............................................. p.2-14
   "Sharing" Property Sheet ............................................. p.2-15

2. Windows NT 4.0
   Operating Environment ................................................ p.2-16
   Installation ..................................................................... p.2-17
   Test Print ...................................................................... p.2-23
   Making General Settings Before Using the Printer .......... p.2-24
   Displaying a Property Sheet ......................................... p.2-25
   Displaying a Property Sheet from the Printer Folder ...... p.2-25
   Displaying a Property Sheet from an Application Menu p.2-25
   "General" Property Sheet ............................................. p.2-27
   "Ports" Property Sheet ................................................ p.2-28
   "Scheduling" Property Sheet ........................................ p.2-29
   "Sharing" Property Sheet ............................................. p.2-30
   "Security" Property Sheet ............................................ p.2-31
<table>
<thead>
<tr>
<th>Chapter3</th>
<th>Property Sheet</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Property Sheets</td>
<td>Property Sheets .................................................. p.3-2</td>
</tr>
<tr>
<td>2. &quot;Device Option&quot; Property Sheet</td>
<td>Functions of the &quot;Device Option&quot; Property Sheet .......... p.3-3</td>
</tr>
<tr>
<td>4. &quot;Advanced&quot; Property Sheet</td>
<td>Functions of the &quot;Advanced&quot; Property Sheet ................ p.3-13</td>
</tr>
<tr>
<td>5. &quot;Graphics&quot; Property Sheet</td>
<td>Functions of the &quot;Graphics&quot; Property Sheet ................ p.3-21</td>
</tr>
<tr>
<td>6. &quot;PostScript&quot; Property Sheet</td>
<td>Functions of the &quot;PostScript&quot; Property Sheet .............. p.3-28</td>
</tr>
<tr>
<td>7. &quot;Settings&quot; Property Sheet</td>
<td>Functions of the &quot;Settings&quot; Property Sheet ................. p.3-33</td>
</tr>
<tr>
<td>8. &quot;Conflict Settings Validation&quot; Dialog Box</td>
<td>&quot;Conflict Settings Validation&quot; Dialog Box ................. p.3-35</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter4</th>
<th>Convenient Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Convenient Functions</td>
<td>Convenient Functions ............................................. p.4-2</td>
</tr>
<tr>
<td>2. Printing More Than One Copy at a Time</td>
<td>Overview .............................................................. p.4-3</td>
</tr>
</tbody>
</table>
3. Printing on Both Sides of the Paper
   Overview ........................................................... p.4-5
   Procedure ......................................................... p.4-5

4. Specifying the Exit Port
   Overview ........................................................... p.4-8
   Procedure ......................................................... p.4-8

5. Specifying N-in-1 Printing
   Overview ........................................................... p.4-10
   Procedure ......................................................... p.4-10

6. Printing in Reduced/Enlarged Size
   Overview ........................................................... p.4-13
   Procedure ......................................................... p.4-13

7. Specifying Booklet Printing
   Overview ........................................................... p.4-16
   Procedure ......................................................... p.4-16

8. Using the Copy Track Function
   Overview ........................................................... p.4-18
   Procedure ......................................................... p.4-18

9. Printing Pages with a Distribution Number
   Overview ........................................................... p.4-24
   Procedure ......................................................... p.4-24

10. Printing Pages with Watermarks
    Overview .......................................................... p.4-26
    Procedure ....................................................... p.4-26

11. Printing on OHP Transparencies
    Overview ........................................................... p.4-29
    Procedure ......................................................... p.4-29

12. Adding a Cover to Each Copy Set
    Overview ........................................................... p.4-31
    Procedure ......................................................... p.4-31

13. Using the Lock Job Function
    Overview ........................................................... p.4-33
    Procedure on the Printer Drive Side ....................... p.4-33
    Procedure on the Machine Side ........................... p.4-39
    Deleting a Job .................................................... p.4-41

14. Using the Settings Function
    Overview ........................................................... p.4-43
    Procedure ......................................................... p.4-43
Chapter 5 Troubleshooting

1. Troubleshooting
   - Unable to Print ................................................................. p.5-2
   - Unable to Make Correct Settings /
     Unable to Print Exactly as Set ................................ p.5-5
   - Poor Print Quality ............................................................ p.5-8
   - Error List .......................................................................... p.5-9

Appendix A

1. Function Combination Matrix
   Function Combination Matrix .......................................... p.A-2

2. Preview Listing
   - [Setting Preview] ............................................................... p.A-9

3. Specifications
   - Specifications ............................................................... p.A-11
   - Font ................................................................................. p.A-13
   - Symbol Sets ................................................................. p.A-15
   - Selectable Paper Sizes .................................................... p.A-16

Appendix B

1. Glossary
   Glossary ........................................................................... p.B-2

Appendix C

1. INDEX
   INDEX ................................................................................ p.C-2
Chapter 1

Before Using the Printer Controller
1-2
1. Features of the Printer Controller

Features of the Printer Controller

The printer controller is an image controller designed to use the machine as a printer, allowing you to print documents directly to the machine from a computer to which the printer controller is connected. The printer driver, which is used during printing, is equipped with various functions that make the most out of the features of the machine. They enable you to use the same functions as those offered by the machine. When actually running a print cycle, you can specify various functions of the machine on your computer screen.

**NOTE**

- When using the printer controller, be sure to set the machine in the On Line state.
- Some functions offered by the machine cannot be combined, such as Staple and Hole-Punch, and others may not be used because of a paper size involved. The functions that cannot be selected either appear dimmed or appended with a \( \times \) before the menu option.

Further, if functions that are incompatible with each other are specified, the Conflict Settings Validation dialog box appears, prompting you to change the settings. When this dialog box appears, check the details and reselect the functions to ensure function compatibility.

Various Printing Functions

- Makes prints that are sorted into complete sets of the originals (Collated) or grouped into uncollated groups, each containing prints of one original (Group).
1. Features of the Printer Controller

- Prints two pages of originals on both front and back sides of a single sheet of paper.

- Enlarges or reduces the image on the original.

- Prints two pages or four pages of originals on a single sheet of paper.

- Prints four pages of originals to both front and back sides of a single sheet of paper.
1. Features of the Printer Controller

- Places text in the background.

- Makes prints of complete sets of the originals, stapled together or punched for filing.

  ![Diagram](image1)

  By combining Sort or Group with other finishing capabilities, you can make complete sets of documents for immediate delivery without having to do any further processing.

  ![Diagram](image2)

- Adds a reference number (Distribution Number) to each document set during printing.

  ![Diagram](image3)
1. Features of the Printer Controller

- Prints only the cover on a different type of paper (such as colored paper).

- Capable of printing on OHP transparencies. You can also insert interleaves, either blank or printed with the same contents as those on the OHP transparencies.

Administrative Functions

- Different accounts can be managed for printing records, just as when using the machine as a copier. The setting of 100 accounts or 1000 accounts depends on the setting made on the machine.
- Printing of confidential documents may be withheld until a legitimate password is entered on the machine.

About PCL5e and PCL6

In PCL6, graphics capability is expanded from that of PCL5e.
2. Configuration

Configuration

The printer controller may be configured with the following options.

- **Memory (32MB/64MB, Option)**
  Expands the memory capacity of Pi3500.

- **Printer Controller**
  Allows you to use the machine as a printer controlled by your personal computer.

- **Hard Disk Drive (Option)**
  For downloading PS fonts for the exclusive use in Macintosh.

- **NIC Board (Option)**
  Allows you to use the machine as a printer in a network environment.

**NOTE**
The Hard Disk Drive is for the exclusive use in Macintosh.
3. Connecting the Printer Controller

Connecting the Printer Controller
The printer controller is mounted on the rear of the machine. The installation procedures are to be performed by the service personnel.

The printer controller is connected to the machine with the engine interface cable and to the computer with a printer cable or network cable. Power to the printer controller is supplied from the machine.

NOTE
Do not connect any peripheral devices to the engine interface cable that is used to connect the printer controller to the machine.

TIP
If you cannot print from your computer, check that the engine interface cable and printer cable are connected to the corresponding connectors.
4. Settings Made on the Machine

The following functions must be set on the machine using its Utility Mode, as they relate to the printer controller.

Priority Device

Select the priority of use of the machine, either as a copier or printer.

Copier: The machine is used as a copier.
   The machine starts the print cycle only after it has received the entire data of a particular print job.
   The machine can be used for copying, since it starts printing only after it has received the entire data of the job for printing. This means that more time is available to you for copying, but you have to wait for a longer time before a particular print job is done.

Printer: The machine is used as a printer.
   The machine starts the print cycle before it completes receiving the entire data of a particular print job.
   On receiving the data for one page, the machine starts printing, accepting no other job for copying. This means that less time is available to you for copying, but you do not have to wait long before a particular print job is done.

On Line

This function is the same as that available in ordinary printers as On Line/Off Line. Select On Line normally.

Test Print

The following six types of test print will be output when a test print is run from the machine:

• CONFIGURATION PRINT
• PCL FONT LIST
• PS FONT LIST
• NETWORK CONFIGURATION PRINT
• PCL DEMO PRINT
• PS DEMO PRINT

Here is the procedure to run a test print. These operations are made on the machine.
1. Press the Utility key.
2. Press the Test Print key.

NOTE

Font lists contain only those fonts that are installed as standard and any fonts later added are not displayed.
4. Settings Made on the Machine

- Refer to the Test Print Outputs
5. Installing the Printer Drivers

Installing Various Printer Drivers

To make 100% use of the functions offered by the machine mounted with the printer controller, install the attached printer drivers in your computer. The printer controller is furnished with the following printer drivers.

- Windows 95 printer drivers
  Digital Copier 25cpm (PCL5e, PCL6, PostScript)
  Digital Copier 35cpm (PCL5e, PCL6, PostScript)

- Windows NT 4.0 printer drivers
  Digital Copier 25cpm (PCL5e, PCL6, PostScript)
  Digital Copier 35cpm (PCL5e, PCL6, PostScript)

- Windows 3.1 printer drivers
  Digital Copier 25cpm (PCL5e, PCL6, PostScript)
  Digital Copier 35cpm (PCL5e, PCL6, PostScript)

- Windows NT 3.51 printer drivers
  Digital Copier 25cpm (PCL5e, PostScript)
  Digital Copier 35cpm (PCL5e, PostScript)

- Macintosh printer drivers

Install the printer driver suitable for the operating system that runs on your computer. For the installation procedures, see the relevant page as detailed below.

Installing the Windows printer driver:
Windows 95⇒ p. 2-2  
Windows NT 4.0⇒ p. 2-16  
Windows 3.1⇒ p. 2-32  
Windows NT 3.51⇒ p. 2-39

Installing the Macintosh printer driver:
See the User’s Manual for Macintosh separately provided.
Chapter 2

Installing the Printer Driver
2-2

1. Windows 95

Operating Environment

This section explains the required environment for the printer driver. Before installing the printer driver, check that your computer meets the following requirements. If it doesn’t, the printer driver may not function properly.

<table>
<thead>
<tr>
<th>Personal computer</th>
<th>IBM PC or a compatible with an i486DX or higher CPU</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Windows 95 (English)</td>
</tr>
<tr>
<td>Memory</td>
<td>8MB or more</td>
</tr>
<tr>
<td>I/O interface</td>
<td></td>
</tr>
<tr>
<td>Parallel</td>
<td>Centronics interface</td>
</tr>
<tr>
<td>Network</td>
<td>10Base-T/2 (UTP/BNC), 10/100BaseT (UTP) ; supported protocols are, IPX/SPX (NetWare 3.1x &amp; 4.x), and TCP/IP (lpr/ldp)</td>
</tr>
<tr>
<td>Free space on hard disk</td>
<td>3MB or more</td>
</tr>
</tbody>
</table>

- **Windows NT 4.0**
  For the operating environment and installation procedure for the Windows NT 4.0 printer driver, see p. 2-16.

- **Windows 3.1**
  For the operating environment and installation procedure for the Windows 3.1 printer driver, see p. 2-32.

- **Windows NT 3.51**
  For the operating environment and installation procedure for the Windows NT 3.51 printer driver, see p. 2-39.
Installation
This section explains the installation procedure for the Windows 95 printer driver.

NOTE
Before starting to install the printer driver, be sure first to quit all applications.

TIP
The following procedure assumes that the machine is a Digital Copier 35cpm and the printer driver is PCL5e. Read the specific proper names as Digital Copier 25cpm and PCL6 or PS as may be necessary depending on your applications.

1. Click the [Start] button. From the menu that appears, select "Settings," then click "Printers."

2. The Printers window will appear. Double-click the "Add Printer" icon.
1. Windows 95

3. The "Add Printer Wizard" will appear. Click the [Next>] button.

4. A window will appear, asking how the printer is to be connected. If your computer is directly connected to the machine, select "Local printer" and then click the [Next>] button.
NOTE

• When installing the printer driver in a computer connected to the machine via a network, be sure to consult the network administrator.
• This is a request to be made of the network administrator. To install the printer driver in a computer connected to a network, select "Network printer" and click the [Next] button. Then, a window will appear prompting you to enter the network path; so enter the path.

5. A window will appear, prompting you to select the manufacturer and model of your printer. Click the [Have Disk...] button on the lower right part of the screen.

6. The "Install From Disk" dialog box will appear. Install the printer controller driver CD-ROM that is included with the printer controller in the CD-ROM drive of your computer.
7. Type the drive name in the "Copy manufacturer's file from" box. (As an example, the CD-ROM drive is drive I.)
   Click the [OK] button.
   To install PCL5e: I:\Win95\PCL5e
   To install PCL6: I:\Win95\PCL6
   To install PS: I:\Win95\PS

8. A "Printers" list appears.
   Select the driver to be installed and click the [Next>] button.
9. A window that prompts you to select the port will appear. Select the port (normally "LPT:"") to which the printer cable has been connected, then click the [Next>] button.

10. A window that asks you to confirm the printer name will appear. Check the printer name. If you want to change the printer name to one that is easy to remember, change it in this step. If you want to designate this printer as the default printer, select "Yes." Click the [Next>] button.
1. Windows 95

11. If you want to print a test page, select "Yes (recommended)." If you elect not to, select "No." It is recommended that a test page be printed to ensure that the printer driver has been installed properly. Now, click the [Finish] button.

12. Installation will start.

When all the files have been copied from the floppy disk, the corresponding icon will be added to the "Printers" window.
This completes the installation.
Test Print

If "Yes [recommended]" has been selected in step 11 to specify printing of a test page, test printing starts. Check that the printer name is correct.

Refer to the Test Print Output.
Making General Settings Before Using the Printer

The printer driver requires setting of items that are common to all print jobs, including the port to which the printer cable is connected and optional devices configured with the machine. These settings must be made using property sheets available from the Properties command after the printer driver has been installed or when the operating environment is changed.

The most common settings have already been made when the printer driver is installed, meaning that you do not usually bother to change them. Some items must, however, be changed in the following cases.

<table>
<thead>
<tr>
<th>Cases where changes are necessary</th>
<th>Applicable property sheets</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>• You want to add a comment to distinguish the printer from others</td>
<td>&quot;General&quot;</td>
<td>p.2-13</td>
</tr>
<tr>
<td>• The computer’s connecting port has been changed</td>
<td>&quot;Details&quot;</td>
<td>p.2-14</td>
</tr>
<tr>
<td>• You want to change the conditions for the display of a timeout error</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• You want to designate a port to which the machine is connected via a network (this setting must be made on a computer connected to the machine via a network)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• You want to share the machine with other computers connected to the same network (this setting must be made on the computer directly connected to the machine)</td>
<td>&quot;Sharing&quot;</td>
<td>p.2-15</td>
</tr>
</tbody>
</table>

For the details of "Device Option," see Chapter 3.
Displaying a Property Sheet

You have two different steps to take to display a property sheet. The contents of a particular property sheet slightly differ depending on how you access it. Select the appropriate one according to your need.

(1) To display a property sheet from the printer folder
(2) To display a property sheet from an application menu

Below are the detailed procedures for each approach.

Displaying a Property Sheet from the Printer Folder

1. Click the [Start] button and select “Settings.” Then, click “Printers.”
2. Click the icon of “Digital Copier 35cpm PCL5e.”
3. Select “Properties” from the menu that will appear. This shows the property sheet.

This method is mainly used when there will be no big changes in the settings once made, such as [Device Option]. It allows you to set the environment in which you will use the printer. The settings made through this method are valid in all applications.

Displaying a Property Sheet from an Application Menu

1. Select [Print...] from the [File] menu of the application.
2. Check that the “Name” of the “Printer” is “Digital Copier 35cpm PCL5e.” If “Digital Copier 35cpm PCL5e” is not selected, click [▼] and, from the menu that will then appear, select “Digital Copier 35cpm PCL5e”
3. Click the [Properties] button. This shows the property sheet.

This method allows you to set the number of copies and paper for each document. The settings made on the property sheet accessed through the application are valid only for that particular application.

**TIP**

To show a property sheet other than Paper, click the corresponding tab located on the top part of the screen.
NOTES

The steps to display a property sheet may be different depending on the application. Follow the correct procedure according to the application. The procedure above is based on the application WordPad.
"General" Property Sheet
This property sheet is commonly available to the Windows 95-based printer drivers.

There is no need of making changes in settings for ordinary operating environments. See Windows 95 Help for more details.

**NOTE**
*If "Separator page" is specified, a separator page can be inserted between multiple print jobs.*
"Details" Property Sheet
This property sheet is commonly available to the Windows 95-based printer drivers.

There is no need of making changes in settings for ordinary operating environments. See Windows 95 Help for more details.
"Sharing" Property Sheet

This property sheet is commonly available to the Windows 95-based printer drivers.

It allows you to make settings for sharing a printer among different users. It is displayed only when a Windows 95-based printer is being used over the network. For more details, see Windows 95 Help for more details.
2. Windows NT4.0

Operating Environment
This section explains the required environment for the printer driver. Before installing the printer driver, check that your computer meets the following requirements. If it doesn’t, the printer driver may not function properly.

<table>
<thead>
<tr>
<th>Personal computer</th>
<th>IBM PC or a compatible with an i486DX or higher CPU</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Windows NT 4.0 (English)</td>
</tr>
<tr>
<td>Memory</td>
<td>8MB or more</td>
</tr>
<tr>
<td>I/O interface</td>
<td></td>
</tr>
<tr>
<td>Parallel</td>
<td>Centronics interface</td>
</tr>
<tr>
<td>Network</td>
<td>10Base-T/2 (UTP/BNC), 10/100BaseT (UTP) ; supported protocols are, IPX/SPX (NetWare 3.1x &amp; 4.x), and TCP/IP (lpr/lpd)</td>
</tr>
<tr>
<td>Free space on hard disk</td>
<td>3MB or more</td>
</tr>
</tbody>
</table>

- Windows 95
  For the operating environment and installation procedure for the Windows 95 printer driver, see p. 2-2.

- Windows 3.1
  For the operating environment and installation procedure for the Windows 3.1 printer driver, see p. 2-32.

- Windows NT 3.51
  For the operating environment and installation procedure for the Windows NT 3.51 printer driver, see p. 2-39.
2. Windows NT4.0

Installation

This section explains the installation procedure for the Windows NT 4.0 printer driver.

**NOTE**
Before starting to install the printer driver, be sure first to quit all applications.

**TIP**
The following procedure assumes that the machine is a Digital Copier 35cpm and the printer driver is PCL5e. Read the specific proper names as Digital Copier 25cpm and PCL6 or PS as may be necessary depending on your applications.

1. Click the [Start] button. From the menu that appears, select "Settings," then click "Printers."

![Start Menu with Printers Option]

2. The Printers window will appear. Double-click the "Add Printer" icon.

![Add Printer Window]
2. Windows NT4.0

3. If the printer is directly connected to the computer, select "My Computer." If the printer is connected via a network printer server, select "Network printer server."

NOTE
When installing the printer driver in a computer connected to the machine via a network, be sure to consult the network administrator.

4. Click the [Next>] button.

5. Select the name of the port to be used and click the [Next>] button.
2. Windows NT4.0

6. A window will appear, prompting you to select the manufacturer and model of your printer. Click the [Have Disk...] button on the lower right part of the screen.

7. The "Install From Disk" dialog box will appear. Install the printer controller driver CD-ROM that is included with the printer controller in the CD-ROM drive of your computer.
2. Windows NT4.0

8. Type the drive name in the "Copy manufacturer's file from" box. (As an example, the CD-ROM drive is drive I.)
   Click the [OK] button.
   To install PCL5e: I:\NT40\PCL5e
   To install PCL6: I:\NT40\PCL6
   To install PS: I:\NT40\PS

   Select the driver to be installed and click the [Next>] button.
10. If you want to change the printer name that is displayed, change the "Printer name" on this screen. If not, leave it as is. Click the [Next>] button.

11. If you share the printer with other users, select "Shared" and type the share name in the box to the right of "Share Name." If not, select "Not shared." Click the [Next>] button.
2-22

2. Windows NT4.0

12. If you want to print a test page, select "Yes (recommended)." If you elect not to, select "No." It is recommended that a test page be printed to ensure that the printer driver has been installed properly. As the last step, click the [Finish] button.

13. Installation will start.

When all the files have been copied from the floppy disk, the corresponding icon will be added to the "Printers" window. This completes the installation.
Test Print

If "Yes (recommended)" has been selected in the step to specify printing of a test page, test printing starts. Check that the printer name is correct.

Refer to the Test Print Output.

Windows NT Printer Test Page

Components:
If you can read this information, you have correctly installed your Digital Copier Image DLX TE on NT/OS/2.

The information below describes your printer driver and port settings.

Machine Name: DIGIPLT

Printer Name: Digital Copier Image DLX TE

Port selected: LPT1

Date Format: US

Date Time: 07:58:22 1999

Directory: C:\WIN\system32

Environment: Windows NT 4.0

Files used by DCLX driver:
C:\WIN\system32\137149200002860\win95oem.dll
C:\WIN\system32\137149200002860\win95oem.dll
C:\WIN\system32\137149200002860\win95oem.dll
C:\WIN\system32\137149200002860\win95oem.dll

This is the end of the printer test page.
2. Windows NT4.0

Making General Settings Before Using the Printer

The printer driver requires setting of items that are common to all print jobs, including the port to which the printer cable is connected and optional devices configured with the machine. These settings must be made using property sheets available from the Properties command after the printer driver has been installed or when the operating environment is changed.

The most common settings have already been made when the printer driver is installed, meaning that you do not usually bother to change them. Some items must, however, be changed in the following cases.

<table>
<thead>
<tr>
<th>Cases where changes are necessary</th>
<th>Applicable property sheet</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>• You want to add a comment to distinguish the printer from others</td>
<td>&quot;General&quot;</td>
<td>p.2-27</td>
</tr>
<tr>
<td>• The computer’s connecting port has been changed</td>
<td>&quot;Ports&quot;</td>
<td>p.2-28</td>
</tr>
<tr>
<td>• You want to change the conditions for the display of a timeout error</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• You want to designate a port to which the machine is connected via a network (this setting must be made on a computer connected to the machine via a network)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• You want to specify a time frame for the machine operation</td>
<td>&quot;Scheduling&quot;</td>
<td>p.2-29</td>
</tr>
<tr>
<td>• You want to share the machine with other computers connected to the same network (this setting must be made on the computer directly connected to the machine)</td>
<td>&quot;Sharing&quot;</td>
<td>p.2-30</td>
</tr>
<tr>
<td>• You want to restrict access to the machine</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• You want to check the accounts of the machine users</td>
<td>&quot;Security&quot;</td>
<td>p.2-31</td>
</tr>
</tbody>
</table>

For the details of "Device Option," see Chapter 3.
Displaying a Property Sheet

You have two different steps to take to display a property sheet. The contents of a particular property sheet slightly differ depending on how you access it. Select the appropriate one according to your need.

(1) To display a property sheet from the printer folder
(2) To display a property sheet from an application menu
Below are the detailed procedures for each approach.

Displaying a Property Sheet from the Printer Folder

1. Click the [Start] button and select "Settings." Then, click "Printers."
2. Click the icon of "Digital Copier 35cpm PCL5e"
   <To display the Device Option sheet>
   3. Click "Properties" from the [File] menu.
   <To display a sheet other than Device Option>
   3. Click [Document Defaults...] from the menu that will then appear. This opens the [Digital Copier 35cpm PCL5e Default].

This method is mainly used when there will be no big changes in the settings once made, such as [Device Option]. It allows you to set the environment in which you will use the printer. The settings made through this method are valid in all applications.

Displaying a Property Sheet from an Application Menu

1. Select [Print...] from the [File] menu of the application.
2. Check that the "Name" of the "Printer" is "Digital Copier 35cpm PCL5e." If "Digital Copier 35cpm PCL5e" is not selected, click [▼] and, from the menu that will then appear, select "Digital Copier 35cpm PCL5e."
3. Click the [Properties] button. This shows the property sheet.

This method allows you to set the number of copies and paper for each document. The settings made on the property sheet accessed through the application are valid only for that particular application.
2-26

2. Windows NT4.0

**TIP**
To show a property sheet other than Paper, click the corresponding tab located on the top part of the screen.

**NOTES**
- The steps to display a property sheet may be different depending on the application. Follow the correct procedure according to the application. The procedure above is based on the application WordPad.
- With PostScript, the contents are different between when the property sheet is accessed from Print Manager and when accessed from an application.
"General" Property Sheet

This property sheet is commonly available to the Windows NT 4.0-based printer drivers.

There is no need of making changes in settings for ordinary operating environments. See Windows NT 4.0 Help for more details.

**NOTE**

*If "Separator page" is specified, a separator page can be inserted between multiple print jobs.*
2. Windows NT4.0

"Ports" Property Sheet

This property sheet is commonly available to the Windows NT 4.0-based printer drivers.

There is no need of making changes in settings for ordinary operating environments. See Windows NT 4.0 Help for more details.
"Scheduling" Property Sheet

This property sheet is commonly available to the Windows NT 4.0-based printer drivers.

There is no need of making changes in settings for ordinary operating environments. See Windows NT 4.0 Help for more details.
2. Windows NT4.0

"Sharing" Property Sheet

This property sheet is commonly available to the Windows NT 4.0-based printer drivers.

There is no need of making changes in settings for ordinary operating environments. See Windows NT 4.0 Help for more details.
"Security" Property Sheet

This property sheet is commonly available to the Windows NT 4.0-based printer drivers.

There is no need of making changes in settings for ordinary operating environments. See Windows NT 4.0 Help for more details.
3. Windows 3.1

Operating Environment

This section explains the required environment for the printer driver. Before installing the printer driver, check that your computer meets the following requirements. If it doesn’t, the printer driver may not function properly.

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Personal computer</td>
<td>IBM PC or compatible with an i486DX or higher CPU</td>
</tr>
<tr>
<td>Operating system</td>
<td>Windows 3.1 (English)</td>
</tr>
<tr>
<td>Memory</td>
<td>8MB or more</td>
</tr>
<tr>
<td>I/O interface</td>
<td>Bidirectional</td>
</tr>
<tr>
<td></td>
<td>parallel</td>
</tr>
<tr>
<td></td>
<td>Centronics interface</td>
</tr>
<tr>
<td>Network</td>
<td>10Base-T/2 (UTP/BNC), 10/100BaseT (UTP) ; supported protocols are, IPX/SPX (NetWare 3.1x &amp; 4.x), and TCP/IP (lpr/ lpd)</td>
</tr>
<tr>
<td>Free space on hard disk</td>
<td>3MB or more</td>
</tr>
</tbody>
</table>

- **Windows 95**
  
  For the operating environment and installation procedure for the Windows 95 printer driver, see p. 2-2.

- **Windows NT 4.0**
  
  For the operating environment and installation procedure for the Windows NT 4.0 printer driver, see p. 2-16.

- **Windows NT 3.51**
  
  For the operating environment and installation procedure for the Windows NT 3.51 printer driver, see p. 2-39.
3. Windows 3.1

Installation
This section explains the installation procedure for the Windows 3.1 printer driver.

**NOTE**
Before starting to install the printer driver, be sure first to quit all applications.

**TIP**
The following procedure assumes that the machine is a Digital Copier 35cpm and the printer driver is PCL5e. Read the specific proper names as Digital Copier 25cpm and PCL6 or PS as may be necessary depending on your applications.

1. Double-click the "Print Manager" icon in the "Main" group.

2. The "Print Manager" dialog box will appear. Select "Printer Setup..." from the [Options] menu.
3. Windows 3.1

3. The lower part of the "Printers" dialog box will appear. Select "Install Unlisted or Updated Printer" and click the [Install...] button.

4. The "Install Driver" dialog box will appear. Install the printer controller driver CD-ROM that is included with the printer controller in the CD-ROM drive of your computer.
3. Windows 3.1

5. Type the drive name in the "Install Driver" dialog box. (As an example, the CD-ROM drive is drive I.)
   Click the [OK] button.
   To install PCL5e: I:\Win31\PCL5e
   To install PCL6: I:\Win31\PCL6
   To install PS: I:\Win31\PS

6. The "List of Printers" appears.
   Select the driver to be installed and click the [OK] button.

7. Installation will start.
When installation is completed, the corresponding icon will be added to the "Installed Printers" list of the "Printers" dialog box. This completes the installation procedure.
Displaying a Property Sheet

You have two different steps to take to display a property sheet. The contents of a particular property sheet slightly differ depending on how you access it. Select the appropriate one according to your need.

1. To display a property sheet from Print Manager
2. To display a property sheet from an application menu

Below are the detailed procedures for each approach.

Displaying a Property Sheet from Print Manager

1. Open [Print Manager] from [Main].
2. Select "Printer" whose properties are to be shown.
4. Then, the [Printers] dialog box appears. Click the printer icon of the property sheet to be displayed.
5. Click the [Setup...] button to show the property sheet.

This method is mainly used when there will be no big changes in the settings once made, such as [Device Option]. It allows you to set the environment in which you will use the printer. The settings made by showing the property sheet from the control panel are valid in all applications.

Displaying a Property Sheet from an Application Menu

1. Select [Print Setup...] from the [File] menu of the application.
2. Then, the Print Setup dialog box appears. Check that the "Default Printer" of "Printer" is "Digital Copier 35cpm PCL5e."
3. Select [Options...] in the Print Setup dialog box. This shows the property sheet.

This method allows you to set the number of copies and paper for each document. The settings made on the property sheet accessed through the application are valid only for that particular application.

**TIP**

To show a property sheet other than Paper, click the corresponding tab located on the bottom part of the screen.
NOTES

• The steps to display a property sheet may be different depending on the application. Follow the correct procedure according to the application.
• The settings made on the property sheet accessed through the application are valid only for that particular application.
4. Windows NT 3.51

Operating Environment

This section explains the required environment for the printer driver. Before installing the printer driver, check that your computer meets the following requirements. If it doesn’t, the printer driver may not function properly.

<table>
<thead>
<tr>
<th>Personal computer</th>
<th>IBM PC or a compatible with an i486DX or higher CPU</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Windows NT 3.51 (English)</td>
</tr>
<tr>
<td>Memory</td>
<td>8MB or more</td>
</tr>
<tr>
<td>I/O interface</td>
<td></td>
</tr>
<tr>
<td>Parallel</td>
<td>Centronics interface</td>
</tr>
<tr>
<td>Network</td>
<td>10Base-T/2 (UTP/BNC), 10/100BaseT (UTP) ; supported protocols are, IPX/SPX (NetWare 3.1x &amp; 4.x), and TCP/IP (lpr/lpd)</td>
</tr>
<tr>
<td>Free space on hard disk</td>
<td>3MB or more</td>
</tr>
</tbody>
</table>

- Windows 95
  For the operating environment and installation procedure for the Windows 95 printer driver, see p. 2-2.

- Windows NT 4.0
  For the operating environment and installation procedure for the Windows NT 4.0 printer driver, see p. 2-16.

- Windows 3.1
  For the operating environment and installation procedure for the Windows 3.1 printer driver, see p. 2-32.
Installation

This section explains the installation procedure for the Windows NT 3.51 printer driver.

NOTE
Before starting to install the printer driver, be sure first to quit all applications.

TIP
The following procedure assumes that the machine is a Digital Copier 35cpm and the printer driver is PCL5e. Read the specific proper names as Digital Copier 25cpm and PCL6 or PS as may be necessary depending on your applications.

1. Double-click the "Print Manager" icon, which is located in the "Main" group within the Windows NT 3.51 Program Manager.

2. The "Print Manager" dialog box will appear.
3. If the printer is directly connected to the computer, select "Create Printer..." from the "Printer" menu. If the printer is connected via a network printer server, select "Connect to Printer..."

**NOTE**

When installing the printer driver in a computer connected to the machine via a network, be sure to consult the network administrator.

4. The "Create Printer" dialog box will appear.
4. Windows NT 3.51

5. Select "Other..." from the drop-down list of the "Driver" box.

6. The "Install Driver" dialog box will then appear. Install the printer controller driver CD-ROM that is included with the printer controller in the CD-ROM drive of your computer and change the drive name to the CD-ROM drive.

7. Type the driver on the "Install Driver" dialog box. (As an example, the CD-ROM drive is drive I.)
   Click the [OK] button.
   To install PCL5e: I:NT351\PCL5e
   To install PS: I:NT351\PS
4. Windows NT 3.51

8. A "Printer Driver" list appears. Select the driver to be installed and click the [OK] button.

9. The printer driver name selected is displayed in the "Driver" box on the "Create Printer" dialog box.
4. Windows NT 3.51

10. Type any desired printer name in the "Printer Name" edit box and click the [OK] button.

11. The [Device Option] property sheet will appear. Make the necessary settings and click the [OK] button.
12. The installed printer driver window will be added to "Print Manager." This completes the installation.
4. Windows NT 3.51

Making General Settings Before Using the Printer

The printer driver requires setting of items that are common to all print jobs, including the port to which the printer cable is connected and optional devices configured with the machine. To use the machine for printing, settings must be made so that the printer driver developed for these machines can be used. These settings may be made using the "Printer Properties" dialog box, and other dialog boxes which can be opened from it.

The most common settings have already been made when the printer driver is installed, meaning that you do not usually bother to change them. Some items must, however, be changed in the following cases.

<table>
<thead>
<tr>
<th>Cases where changes are necessary</th>
<th>Applicable property sheet</th>
<th>Ref. page</th>
</tr>
</thead>
<tbody>
<tr>
<td>• The name of the printer to be used is not Digital Copier 35cpm PCL5e.</td>
<td>&quot;Printer Properties&quot;</td>
<td>p.2-49</td>
</tr>
<tr>
<td>• The computer’s connecting port has been changed</td>
<td>&quot;Printer Details&quot;</td>
<td>p.2-50</td>
</tr>
<tr>
<td>• You want to change the conditions for the display of a timeout error</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• You want to designate a port to which the machine is connected via a network (this setting must be made on a computer connected to the machine via a network)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

For the details of "Device Option," see Chapter 3.
Displaying a Property Sheet
You have two different steps to take to display a property sheet. The contents of a particular property sheet slightly differ depending on how you access it. Select the appropriate one according to your need.

(1) To display a property sheet from Print Manager
(2) To display a property sheet from an application menu

Below are the detailed procedures for each approach.

Displaying a Property Sheet from Print Manager:
1. Open [Print Manager] from [Main].
2. Then, the [Printers] dialog box appears. Click the printer icon of the property sheet to be displayed.
3. Select "Properties" from the "Printer" menu.

<To display the Device Option screen>
4. Click the [Setup...] button.

<To display a screen other than Device Option>
5. Click the [Details...] button.
6. Click the [Job Defaults...] button.

This method is mainly used when there will be no big changes in the settings once made, such as [Device Option]. It allows you to set the environment in which you will use the printer. The settings made by showing the property sheet from Print Manager are valid in all applications.

Displaying a Property Sheet from an Application Menu
1. Select [Print Setup...] from the [File] menu of the application.
2. Then, the Print Setup dialog box appears, showing the conditions of the printer being used. Check that the "Name" of "Printer" is "Digital Copier 35cpm PCL5e."
3. Select [Properties] in the Print Setup dialog box. This shows the property sheet.

This method allows you to set the number of copies and paper for each document. The settings made on the property sheet accessed through the application are valid only for that particular application.
4. Windows NT 3.51

**TIP**
To show a property sheet other than Paper, click the corresponding tab located on the bottom part of the screen.

**NOTES**
- The steps to display a property sheet may be different depending on the application. Follow the correct procedure according to the application.
- The PostScript property sheet of the PostScript driver may be accessed by either one of the following three ways: (1) click the “Print Manager” icon, then choose [Properties] and then [Setup...]; (2) click the “Print Manager” icon, then choose [Properties], [Details], and then [Job Default]; or (3) through the application.
  Note that the contents of the screen accessed through approaches (2) and (3) are the same, while they are different from those of the screen accessed through approach (1).
4. Windows NT 3.51

"Printer Properties" Dialog Box

This dialog box is commonly available to the Windows NT 3.51-based printer drivers.

There is no need of making changes in settings for ordinary operating environments. See Windows NT 3.51 Help for more details.
4. Windows NT 3.51

"Printer Details" Dialog Box

This dialog box is commonly available to the Windows NT 3.51-based printer drivers.

There is no need of making changes in settings for ordinary operating environments. See Windows NT 3.51 Help for more details.
Chapter 3

Property Sheet
1. Property Sheets

Property Sheets

Each property sheet allows you to make specific settings as detailed below. For a detailed description of each function, see the corresponding reference page.

<table>
<thead>
<tr>
<th>Property Sheet</th>
<th>Available Settings</th>
<th>Reference Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Device Option&quot;</td>
<td>Allows you to make settings for options installed on the machine. * This property sheet is not displayed when Properties has been opened from the application.</td>
<td>p.3-3</td>
</tr>
<tr>
<td>&quot;Paper&quot;</td>
<td>Allows you to make basic printer settings such as the number of copies, paper size, print orientation, and the paper source loaded with the paper for printing. It allows you to set enhanced printer functions such as duplex printing, N-in-1 printing, print zoom ratio, and booklet creation. It further allows you to set finishing capabilities including sort, staple, and hole punch when you need to make multiple, complete sets of the original document. Still another feature that can be set is the Administrator Mode.</td>
<td>p.3-5</td>
</tr>
<tr>
<td>&quot;Advanced&quot;</td>
<td>Allows you to make settings for advanced functions, such as OHP interleaving, document distribution number, and watermark. It is also possible to lock a print job.</td>
<td>p.3-14</td>
</tr>
<tr>
<td>&quot;Graphics&quot;</td>
<td>Allows you to make graphic settings such as resolution, halftone, and image processing method. It also allows you to set TrueType fonts.</td>
<td>p.3-21</td>
</tr>
<tr>
<td>&quot;PostScript&quot; (PS driver only)</td>
<td>Allows you to make detailed settings concerning PostScript.</td>
<td>p.3-28</td>
</tr>
<tr>
<td>&quot;Setting&quot;</td>
<td>Allows you to save the details of settings made and later load the data for use in print jobs.</td>
<td>p.3-33</td>
</tr>
</tbody>
</table>

NOTES
* Refer to Chapter 2 for the procedures to display "Properties."
* Different settings must be made depending on the driver involved.
* The descriptions contained herein are based on the PCL 5e version driver for Windows 95. Peculiarities of each driver are given at the appropriate place in text as supplementary information.
* OS-dependent functions are not detailed.
2. "Device Option" Property Sheet

Functions of the "Device Option" Property Sheet

The "Device Option" property sheet allows you to set the options installed on the machine. Make sure that the correct settings are made; otherwise, some printer functions may not function properly or printing cannot be performed correctly. The settings should match the machine configuration.

![Diagram of Property Sheet](image)

(1) Installed Drawer
Set the drawer installed in the machine. If the bottommost Drawer is the LCC, select LCC, instead of Drawer 3 or Drawer 4.
Setting values: Drawer 1, Drawer 2, Drawer 1, 2, 3, Drawer 1, 2, 3, 4, Drawer 1, 2, 3, 4, 5, Drawer 1, 2 + LCC, Drawer 1, 2, 3 + LCC

(2) Duplex Unit
Set whether the Duplex Unit is installed or not.
Setting values: Installed, Not Installed
2. "Device Option" Property Sheet

(3) Finisher
Set the specifications of the finishing option installed on the machine.
Setting values: Not Installed, Job Tray, Shift Tray, Finisher, Mailbin Finisher

NOTE
If Installed Tray has not been properly selected, it may be impossible to select Finisher properly.

(4) Punch
Set the number of holes to be made in Hole Punch.
Setting values: 4 Holes

NOTE
The setting depends on the capabilities of the Finisher or Mailbin Finisher, whichever is configured with the system.

(5) Mail Bin Name
If the machine is equipped with a Mailbin Finisher, you can name each bin.
Setting values: 1 to 8 characters

(6) Displays the machine preview that represents the configuration of the machine and options.
For preview listing, see p. A-7.

(7) User Name
The user name (up to eight characters) set in the printer driver is displayed as the job user name on the machine’s Touch Panel.
Setting value: 8 characters max.

(8) About...
Click to display the manufacturer and version number of the printer driver.

(9) Restore Defaults
Click to restore all settings to the defaults.
Install Drawer: Drawer 1,2
Duplex Unit: Not Installed
Finisher: Not Installed
Punch: 4 Holes
Mail Bin Name: Bin 1~Bin 5
3. "Paper" Property Sheet

Functions of the "Paper" Property Sheet

The "Paper" property sheet allows you to make basic printer settings.

(1) Access Code
Select this check box when the Administrator Mode is used. An access number is appended to the print job, allowing the machine to keep track of the print job. To use this function, the Copy Track function must be enabled in the machine. When the Copy Track function is enabled in the machine, printing may not be effected unless the correct access number authorized by the machine is entered in Access Number of Security. For more details, see p. 3-13.

(2) Paper preview
Displays the text as it will appear when printed on a sheet of paper. It helps you visualize how N-in-1, duplex, or any other printing function results in the printout. For a paper preview listing, see p. A-4.
3. "Paper" Property Sheet

(3) Paper Size
Select the size of the paper to be used for printing.

**NOTE**
If a paper size that does not match the paper loaded in the machine is selected, the machine will give a message that prompts you to add paper in Drawer1, entering a standby state. If Bypass has been selected, the machine will issue a message that prompts you to load paper in the manual feed port, entering a standby state.

(4) Paper Source
Select the paper source to be used by the machine.
Available options are limited depending on the type of paper source mounted in the machine.
• Auto: Automatically selects the paper source in which paper of the size specified by Paper Size is loaded.
• Drawer 1 to Drawer 5, LCC: Prints on paper loaded in the specified paper source (Drawer).
• Bypass: Prints on paper loaded in the Multi Bypass Tray.

**NOTES**
• It is possible that an option cannot be selected depending on the paper size. For details, see the Operator's Manual of the machine.
• If "OHP Interleaving" or "Cover Mode" is selected, "Paper Source" will appear dimmed.

**TIPS**
• The paper source type is set with Device Option.
• The machine preview shows the paper source to be used in blue.
(5) Paper Output
Select the machine exit tray into which the prints are to be fed. Available options are limited depending on the type of the finishing option configured with the machine.
- Not Installed: Top Output Bin
- Job Tray: 1st/2nd Tray
- Shift Tray: Shift Tray
- Finisher: TopOffset Tray, Elevator Tray
- Mailbin Finisher: TopOffset Tray, Elevator Tray, bin1 to bin5

**NOTE**
It is possible that an option cannot be selected depending on the paper size. For details, see the Operator’s Manual of the machine.

**TIPS**
- The finishing option type is set with Device Option.
- The machine preview shows the exit tray to be used in blue.

(6) Collate
Select whether printed pages are to be sorted into copy sets when printing more than one copy of the same document.
- Collated: Sorts pages into copy sets. For instance, when printing 5 sets of a document consisting of 10 pages, printed pages are sorted by copy (i.e., 5 sets of a 10-page document are output).
- Uncollated: Simply prints the specified number of pages one page at a time. For instance, when printing 5 sets of a document, pages are printed five times, one page at a time.
- Group: Simply prints the specified number of pages which are sorted into groups of the same pages.

**NOTE**
Be sure to set Collate (Sort) on the application to “OFF” at all times.
3. "Paper" Property Sheet

TIPS
• When the machine is equipped with a Shift Tray, or if "Elevator Tray" is selected when the machine is equipped with a Finisher or Mailbin Finisher, sets or stacks are stacked in a sawtooth manner so that each is easy to identify.
• If a Job Tray is mounted, or if none of the finishing options is mounted, sets or stacks are stacked in a crisscross manner.
• The followings are the minimum requirements for enabling crisscross sorting with the Collated setting:
  The stacks of paper of the same size are loaded in the lengthwise and crosswise direction.
  Staple, Hole-Punch, or Cover is not set.

(7) Machine preview
The machine preview shows the set paper source and exit tray in blue or light blue.
For a listing of machine preview formats, see p. A-7.

(8) Hole Punch <when Finisher or Mailbin Finisher is mounted>
Select whether to punch holes in the printed pages.
• None : Does not punch holes.
• Short Edge : Punches holes along the short edge of the document.
• Long Edge : Punches holes along the long edge of the document.

NOTES
• It is possible that no holes are made depending on the paper size and the specified hole position. For details, see the Operator’s Manual of the machine.
• Holes may not be punched if Long Edge is selected with manual feed copying.

TIPS
• The number of holes to be made is set with Device Option.
• The print preview displays the positions of the holes to be made.

(9) Staple <when Finisher or Mailbin Finisher is mounted>
Select whether to staple each copy set of the document.
• None : Does not staple the printed pages.
• Corner : Staples each copy set at the upper left corner.
NOTES
• Select "Elevator Tray" for "Paper Output" when Staple is to be used.
• The stapling position varies between the upper left corner and upper right corner depending on the direction of the paper loaded and the printing orientation.
• If the number of sheets of paper exceeds the limit that the Finisher or Mailbin Finisher can handle, the stapling function may be canceled.
• If the original document for a print job contains a page with a different size from the others and this document is printed, the Staple setting may be canceled.
• If the original document for a print job contains a page with a different direction from the others, care should be used because the stapling position is determined according to the direction of the first page.
• It is possible that an option cannot be selected depending on the paper size. For details, see the Operator’s Manual of the machine.

TIP
The print preview allows you to check for the stapling position.

(10) Setting preview
Displays the icons corresponding to the settings made for the printer driver. It allows you to identify which functions are currently enabled.
For the setting preview listing, see p. A-9.

(11) Copies
Set the number of copies to be made. Directly type the number, or click [▲] or [▼] to arrive at the desired number.
Setting range Digital Copier 25cpm : 1 to 99
Digital Copier 35cpm : 1 to 999

NOTE
Set “1” in "Copies" when using OHP Interleaving and manual feed copying.

(12) Orientation
Select the orientation of the image. The selected orientation may be checked with the paper preview.
• Portrait : Prints the document across the narrower dimension of the paper.
• Landscape : Prints the document across the wider dimension of the paper.
3. "Paper" Property Sheet

**TIP**

The paper preview displays the orientation, either Portrait or Landscape.

(13) Duplex Print <only when Duplex Unit is mounted>

Select the desired duplex print function. The results of the specified duplex print function can be viewed on the paper preview.

- **None**: Does not perform duplex printing.
- **Bind Short Edge**: Prints on both sides of each page so that the printed pages can be bound along the short edge.
- **Bind Long Edge**: Prints on both sides of each page so that the printed pages can be bound along the long edge.

**TIPS**

- The paper sizes that permit Duplex Print are Ledger, 11”x14”, Legal, Letter, Executive, A3, A4, A5, B4, B5, FLS1, FLS2, FLS3, and FLS4.
- The paper preview shows the result, either Bind Short Edge or Bind Long Edge.
3. "Paper" Property Sheet

(14) Form
Set the print layout.
- 1in1: Prints one page to one full-size sheet of paper.
- 2in1: Prints two pages to one sheet of paper.
- 4in1 (Vert.): Prints four pages to one sheet of paper.
- 4in1 (Horiz.): Prints four pages to one sheet of paper.

• Zoom: Prints at an enlargement or reduction.
• Booklet: Prints four pages to both sides of a single sheet of paper so that the output page can be folded at the center to form a booklet.

NOTES
- Duplex printing of 4in1 is available only in Digital Copier 35cpm.
- When a document that contains pages of different size and orientation from the rest is printed by Booklet, void or overlapped image could result.

TIP
The paper preview displays the printout layout.

(15) Paper
Specify the output paper size used in 2in1, 4in1, Zoom, and Booklet.
### 3. "Paper" Property Sheet

(16) Restore Defaults

Resets all settings on the Paper, Advanced, Graphics, and PostScript property sheets to the defaults.

* Paper property sheet

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Job Number</td>
<td>Off</td>
</tr>
<tr>
<td>Paper Size</td>
<td>A4</td>
</tr>
<tr>
<td>Paper Source</td>
<td>Auto</td>
</tr>
<tr>
<td>Paper Output (Not installed)</td>
<td>Top Output Bin</td>
</tr>
<tr>
<td>(Shift Tray)</td>
<td>Shift Tray</td>
</tr>
<tr>
<td>(Job Tray)</td>
<td>1st/2nd Tray</td>
</tr>
<tr>
<td>(Finisher)</td>
<td>Top Offset Tray</td>
</tr>
<tr>
<td>(Mailbin Finisher)</td>
<td>Top Offset Tray</td>
</tr>
<tr>
<td>Finishing (Collate)</td>
<td>Collated</td>
</tr>
<tr>
<td>(Hole Punch)</td>
<td>None</td>
</tr>
<tr>
<td>(Staple)</td>
<td>None</td>
</tr>
<tr>
<td>Copies</td>
<td>1</td>
</tr>
<tr>
<td>Orientation</td>
<td>Portrait</td>
</tr>
<tr>
<td>Duplex Print</td>
<td>None</td>
</tr>
<tr>
<td>Layout (Form)</td>
<td>1in1</td>
</tr>
<tr>
<td>(Paper)</td>
<td>A4</td>
</tr>
</tbody>
</table>

**TIPS**

* For the defaults in the Advanced, Graphics, and PostScript property sheets, see "Restore Defaults" of the corresponding property sheet.

* For the defaults of the PostScript property sheet of Windows NT 4.0/3.51, see "Restore Defaults" of the property sheet accessed via the application.
"Security" Dialog Box

This dialog box is used to enter the access number and the password for a Lock Job.

(1) Enter the access number of the job.
   Setting value : 0001 to 1000 (4 digits)

(2) Enter the password for the Lock Job.
   Setting value : 0000 to 9999 (4 digits)

**NOTES**

- If the [Cancel] button is clicked in the Windows 95/3.1 driver, the data is transmitted without specifying Access Code or Lock Job. It is not the cancellation of data transmission.
- When Access Code is used, printing may not be effected unless the access number has been correctly set. It is possible, by using the utility that comes with the NIC Board (option), to check on the personal computer screen to see whether the job has been canceled or not.

Displaying the "Security" Dialog Box

<Windows 95>

The dialog box appears when the [OK] key is clicked on the "Printer" dialog box if "Access Code" or "Lock Job" has been selected.

<Windows NT 4.0/NT 3.51>

The dialog box appears immediately after "Access Code" or "Lock Job" has been selected.

<Windows 3.1>

The dialog box appears when "Print" of "File" is selected if Access Code or Lock Job has been selected.
Functions of the "Advanced" Property Sheet

The "Advanced" property sheet allows you to make advanced printer settings.

(1) Distribution Number
Select whether to print a distribution number in the background. Other conditions for the distribution number printing may also be specified as detailed below. The distribution number is printed for each set of prints.

- Print page designation: Select whether the distribution number is to be printed on the first page only or every page.
  - Setting values: 1st Page Only, All Pages
- Image Density: Set the image density of the distribution numbers.
  - Setting values: Normal, Darker, Lighter
- Starting Number: Specify the starting distribution number.
  - Setting range: 001 to 999

**NOTE**
When this function is used in combination with Cover Mode and, if "With Image" is not selected under Cover Mode and "All Pages" is selected under this function, the distribution number is printed on the cover.
4. "Advanced" Property Sheet

**TIPS**
- The setting preview shows the corresponding icon.
- The distribution number is reset to 000 upon reaching 999.

(2) Watermark
Allows you to print specific characters as a watermark in the background. The selected watermark can be viewed in the print preview on the left.
- Print page designation: Select whether to print the watermark on the first page only or on every page.
  - Setting values: 1st Page Only, All Pages
- Text: Select the desired characters from the text list.
  - Setting values: CONFIDENTIAL, COPY, DRAFT, FILE COPY, FINAL, PROOF, TOP SECRET, WaterMark1 ~ WaterMark5
- [Edit] button: Displays the "Watermark" dialog box that allows you to set the style or position of the watermark. For more details, see p. 3-19

**NOTE**
When this function is used in combination with Cover Mode and, if "With Image" is not selected under Cover Mode and "1st Paper Only" is selected under this function, the watermark is printed on the second page.

**TIP**
The setting preview shows the corresponding icon.

(3) Lock Job
Select this box if you want to lock a print job.
To use Lock Job, enter a password in Password of Security.
For details, see p. 2-13.
The locked print job may be printed when unlocked on the Job List display available on the machine, at which time, an authorized password is necessary.
4. "Advanced" Property Sheet

(4) OHP Interleaving

When printing on several sheets of OHP transparencies at one time, it is a good idea to insert a sheet of paper between sheets of OHP transparencies. This paper may be left blank or have the same data printed on it as the OHP transparencies.

- **OHP Paper Source**: Select the paper source from which to feed OHP transparencies.
  - Setting values: Drawer 1, Bypass

- **Interleaving Paper Source**: Select the paper source from which to feed interleaves.
  - Setting values: Drawer 1 to Drawer 5, LCC

- **with Image**: Select this box if you want the OHP data printed on the interleaves.

**NOTES**

- Set "1" in "Copies" when using OHP Interleaving.
- The same paper source cannot be selected for "OHP Paper Source" and "Interleaving Paper Source."
- Applicable paper sizes are "A4 & B5".

**TIPS**

- The machine preview shows the paper source for OHP transparencies in blue and that for interleaves in light blue.
- "Paper Source" on the "Paper" property sheet appears dimmed and becomes unavailable when "OHP Interleaving" is selected.
- The setting preview shows the corresponding icon.
4. "Advanced" Property Sheet

(5) Cover Mode

Lets you place a front cover and a back cover in each of your copy sets. The front cover may be left blank or have data printed on it.

- **Paper Source**: Select the paper source for the text pages.
  Setting values: Drawer 1 to Drawer 5, LCC

- **Front Cover Paper Source**: Select the paper source for the front and back covers.
  Setting values: Drawer 1 to Drawer 5, LCC

- **with Image**: Select this box if you want data printed on the front cover.
- **with Back Cover**: Select this box if you want a back cover.

**NOTE**

If thick paper or other special paper is selected, the machine may not feed prints out into the selected exit tray.

**TIPS**

- No data will be printed on the back cover if selected even when you select to print data on the front cover.
- The machine preview shows the paper source for the text pages in blue and that for front and back covers in orange.
- "Paper Source" on the "Paper" property sheet appears dimmed and becomes unavailable when "Cover Mode" is selected.
- The setting preview shows the corresponding icon.
4. "Advanced" Property Sheet

(6) Restore Defaults
Resets all settings on the Paper, Advanced, Graphics, and PostScript property sheets to the defaults.

- Advanced property sheet
  Distribution Number : Off
  (Image Density) : Normal
  (Starting Number) : 1
  Watermark : Off
  (Text) : CONFIDENTIAL
  OHP Interleaving : Off
  (OHP Paper Source) : Drawer1
  (Interleaving Paper Source) : Drawer2
  (with Image) : Off
  Cover Mode : Off
  (Paper Source) : Drawer1
  (Front Cover Paper Source) : Drawer1
  (with Image) : Off
  (with Back Cover) : Off

**TIPS**
- For the defaults in the Paper, Graphics, and PostScript property sheets, see "Restore Defaults" of the corresponding property sheet.
- For the defaults of the PostScript property sheet of Windows NT 4.0/3.51, see "Restore Defaults" of the property sheet accessed via the application.
"Watermark" Dialog Box

The "Watermark" dialog box allows you to select the text to be inserted by the Watermark function and its style. Select text of "Watermark" on the "Advanced" property sheet and click the [Edit] button to show the "Watermark" dialog box.

(1) Text
   Edit the text to be printed as the watermark.
   No. of settings available : 5 (Watermark1 to Watermark5)
   No. of characters : Within 63

   **TIP**
   Only the text for Watermark1 to Watermark5 can be edited. The set phrases of CONFIDENTIAL, COPY, DRAFT, FILE COPY, FINAL, PROOF, and TOP SECRET cannot be edited.

(2) Fonts
   Specify the font of the text to be printed as the watermark.
   When PCL5e is being used with Windows 95, 3.1, or NT 4.0, select one from among those installed in the OS (PC fonts).
   When PCL6 or PS is being used with Windows 95, 3.1, or NT 4.0, or when Windows NT 3.51 is being used, select one from among those installed in the controller.
4. "Advanced" Property Sheet

(3) Style
Specify the font style of the text to be printed as the watermark.
Setting value : Regular, Bold, Italic, Bold Italic

(4) Size
Specify the font size of the text to be printed as the watermark.
Setting value : 4 to 127 pt (step: 1 pt)

(5) Darkness
Specify the image density of the text to be printed as the watermark.
Setting value : Image density corresponding to 0 to 10 (step 1)

(6) Angle
Specify the angle of the text to be printed as the watermark. The specified angle can be viewed in the print preview on the right.
Setting value : -90 to +90 (-: clockwise; 0: horizontal; +: counterclockwise)

(7) Position
Specify the position of the text to be printed as the watermark.
• Automatically Center Watermark : Prints the watermark at the center of the page.
• Position Relative to Center : Prints the watermark at a position defined by the numerical values entered in the X and Y boxes. The specified position can be viewed in the print preview on the right.
Setting value :
X: -200 to 200 (step: 1)
Y: -200 to 200 (step: 1)

**TIP**
For position, specify the distance from the center. The + direction in X is towards the right, while the + direction in Y is upwards.
5. "Graphics" Property Sheet

The "Graphics" property sheet allows you to make graphic settings such as resolution, halftone, print image density, and image processing method.

Functions of the "Graphics" Property Sheet

Property Sheet for PCL5e

(1) Graphics Mode
   Select the graphic image type, either vector or raster.
   - Use Vector Graphics: Transmits the data as vector graphics.
   - Use Raster Graphics: Expands vector graphics data to transmit bit-mapped graphics data.

   **NOTE**
   Use Raster Graphics cannot be used in 2in1, 4in1, Zoom, and Booklet.

(2) Resolution
   Select the desired print resolution.
   Setting value: 600 dpi
5. "Graphics" Property Sheet

(3) Halftone
Allows you to select the desired gray-scale dithering method.
• None : Does not perform dithering. Print results will have no gray
  gradation.
• Coarse : Performs coarse dithering. It is effective when a mixture of
  graphics and text is printed on paper with a rough surface.
• Fine : Performs dithering using dots. Select this option if the
  document contains gray areas.

(4) TrueType fonts
Specify the print method of TrueType fonts.
• Download as Outline : Transmits the data in the outline format if the
  corresponding font is not available.
• Download as Bitmap : Transmits the data in bit-map format if the
  corresponding font is not available.

**NOTE**
This setting is valid if "Print as Graphics image" is OFF.

(5) Print text as graphics image
Transmits all data in the bit-map format.

(6) Restore Defaults
Resets all settings on the Paper, Advanced, and Graphics property sheets to the
defaults.
• Graphics property sheet
  Graphics Mode : Use Vector Graphics
  Resolution : 600 dpi
  Halftone : Fine
  TrueType Fonts : Download as Outline
  Print as Graphics image : Off

**TIP**
For the defaults in the Paper, Advanced, and PostScript property sheets, see
"Restore Defaults" of the corresponding property sheet.
Property Sheet for PCL6

(2) Resolution
See the description for the PCL5e version.

(4) TrueType fonts
See the description for the PCL5e version.

(7) Halftone
Allows you to select the desired gray-scale dithering method.
- Normal : Does not perform dithering. Print results will have no gray gradation.
- Line Art : Performs dithering using lines. Select this option if the document contains clear borders between white, black, and gray shadings like line-drawings.
5. "Graphics" Property Sheet

(8) Restore Defaults
Sets all settings on the Paper, Advanced, and Graphics property sheets to the defaults.

- Graphics property sheet
  - Resolution: 600 dpi
  - Halftone: Normal
  - TrueType Fonts: Download as Outline

**TIP**
For the defaults in the Paper, Advanced, and PostScript property sheets, see "Restore Defaults" of the corresponding property sheet.

Property Sheet for Windows 95/3.1 PS

(2) Resolution
See the description for the PCL5e version.
5. "Graphics" Property Sheet

(9) Halftone
   Allows you to select the desired gray-scale dithering method.
   • Use Printer’s settings: Uses the settings made on the printer.
   • Use settings below: Set the number of lines per inch and the angle of
     pattern. Adjust these settings if Moiré occurs when printing a fine image such as a photo.
     Screen frequency
     Set the number of lines for the screen.
     Setting value: 1 to 600 (step: 1)
     Screen angle
     Set the angle for the screen.
     Setting value: 1 to 360 (step: 1)

   NOTE
   Usually, use the default values.

(10) TrueType fonts
   • Send TrueType fonts to printer according to the font
     : Transmits TrueType fonts according to table correspondence.
     [Edit the table...]: <Only when opened from the control panel>
     Displays a screen on which the system fonts (Device fonts) are assigned to the PC fonts
     (TrueType fonts).
   • Always use built-in printer fonts instead of TrueType fonts
     : Uses the printer fonts at all times.
   • Always use TrueType fonts: Transmits the TrueType fonts at all times.

(11) Special
   Specify reversal of toner arrangement between black and white and mirror image.
   • Negative Image: Reverses toner arrangement between black and white.
   • Mirror Image: Reverses the image as if the original were viewed in a mirror.
5. "Graphics" Property Sheet

(12) Restore Defaults
Resets all settings on the Paper, Advanced, Graphics, and PostScript property sheets to the defaults.

- Graphics property sheet
  Resolution : 600 dpi
  Halftone : Use Printer’s settings
    (Screen frequency) : 60
    (Screen Angle) : 45
  TrueType Fonts : Send True Type fonts to printer according to the font
  Special (Negative Image) : Off
  (Mirror Image) : Off

TIP
For the defaults in the Paper, Advanced, and PostScript property sheets, see "Restore Defaults" of the corresponding property sheet.

Property Sheet for Windows NT 4.0/NT 3.51 PS
5. "Graphics" Property Sheet

(2) Resolution
See the description for the PCL5e version.

(11) Special
See the description for the Windows 95/3.1 PS version.

(13) Halftone [Color Adjustment...]
Displays the color adjustment dialog box.
The color adjustment dialog box is a Windows NT function. For details, see the documentation provided for Windows NT.

(14) TrueType Fonts
• Send TrueType fonts to printer according to the font
  : Transmits TrueType fonts according to table correspondence.
• Always use TrueType fonts: Transmits the TrueType fonts at all times.

(15) Restore Defaults
Resets all settings on the Paper, Advanced, Graphics, and PostScript property sheets to the defaults.
• Graphics property sheet
  Resolution : 600 dpi
  TrueType Fonts : Send True Type font to printer according to the font.
  Special (Negative Image) : Off
  (Mirror Image) : Off

TIPS
• For the defaults in the Paper, Advanced, and PostScript property sheets, see "Restore Defaults" of the corresponding property sheet.
• For the PostScript property sheet, see "Restore Defaults" of the property sheet accessed via the application.
3-28

6. "PostScript" Property Sheet

The "PostScript" property sheet allows you to make overall settings as they relate to PostScript.

Functions of the "PostScript" Property Sheet

Property Sheet for Windows 95/3.1 PS

(1) PostScript output format
Set the output format of PostScript.
• PostScript: Optimizes for faster printing process.
• Encapsulated, PostScript (EPS): Describes an image or page contained within a file and places the file within another application for printing.

(2) PostScript header
Set the method of transmitting the header.
• Download header with each print job: Transmits header information for each print job. It is recommended when sharing a network printer.
• Assume header is downloaded and retained: Transmits header information only once to the printer, thereby shortening the print time.
6. "PostScript" Property Sheet

(3) Ctrl+D
Informs the machine of the start and completion of the current print job.
  • Send CTRL+D before job : Send Ctrl+D before the job.
  • Send CTRL+D after job : Send Ctrl+D after the job.

(4) Print PostScript error information
Check this box to print PostScript error information.

(5) PostScript timeout values
Set the timeout of the printer.
  • Job timeout : Set the timeout value for a job.
    Setting value : 0 to 999 (step: 1)
  • Wait timeout : Set the timeout value for job wait.
    Setting value : 0 to 999 (step: 1)

(6) Bitmap compression
Specify whether to perform bitmap compression or not.
  • Compress bitmap image : Transmits graphics data after compressing it.
  • No bitmap compression : Transmits graphics data without compressing it.

(7) Restore Defaults
Resets all settings made on the Paper, Advanced, Graphics, and PostScript property sheets to the defaults.
  • PostScript property sheet
    PostScript output format : PostScript
    PostScript header : Download header with each print job
    Ctrl+D (Send CTRL+D before job) : Off
      (Send CTRL+D after job) : Off
    Print PostScript error information : On
    PostScript Timeout values
      (Job Timeout) : 0
      (Wait Timeout) : 240
    Bitmap Compression : Compress bitmap images

**TIP**
For the defaults in the Paper, Advanced, and Graphics property sheets, see "Restore Defaults" of the corresponding property sheet.
6. "PostScript" Property Sheet

Property sheet accessed from a Windows NT 4.0/NT 3.51 PS application

(1) PostScript Output Format
   See the Windows 95/3.1 PS version.

(2) PostScript Header
   See the Windows 95/3.1 PS version.

(3) Ctrl+D
   See the Windows 95/3.1 PS version.

(6) Bitmap Compression
   See the Windows 95/3.1 PS version.
(8) Restore Defaults
Resets all settings made on the Paper, Advanced, Graphics, and PostScript property sheets to the defaults.

- PostScript property sheet
  - PostScript Output Format: PostScript
  - PostScript Header: Download header with each print job
  - Ctrl+D (Send CTRL+D before job): Off
  - (Send CTRL+D after job): Off
  - Bitmap Compression: Compress bitmap images

**TIP**
For the defaults in the Paper, Advanced, and Graphics property sheets, see "Restore Defaults" of the corresponding property sheet.

Property sheet accessed from a Windows NT 4.0/NT 3.51 PS control panel
6. "PostScript" Property Sheet

(5) PostScript Timeout values
See the Windows 95/3.1 PS version.

(9) Halftone
Set the halftoning.
• Use Printer Halftoning : Uses the printer setting.
• Use System Halftoning : Uses the unique setting made by the user.
• Halftone Setup... : Displays the device color/halftone property dialog box.
  A Windows NT function is used. For details, see the documentation provided for Windows NT.

(10) Font Substitute
Set font substitution.
• Normal : Substitutes PostScript fonts for all TrueType fonts. A shorter printing time results since the TrueType fonts are not downloaded at printing. There may, however, be some discrepancies in fonts between what you see on the screen and what you get on printout.
• Slowly : Downloads TrueType fonts at printing. So, there is an accurate font correspondence between what you see on the screen and what you get on printout. A longer printing time could result.
• Edit Substitute Table... : Opens the TrueType font to printer font correspondence table.

(11) Restore Defaults
Resets all settings to the defaults.
Halftone : Use Printer Halftoning
Font Substitute : Normal
PostScript timeout values
(Job Timeout) : 0
(Wait Timeout) : 240

TIP
The settings on other property sheets are not reset to defaults.
7. "Settings" Property Sheet

Functions of the "Settings" Property Sheet

The "Settings" property sheet allows you to save the changes made to the settings or view the saved or current settings.

(1) Setting
Displays the settings selected in Title in a tree form.

(2) Title
Displays the title given to the settings programmed in the printer driver.

(3) [Restore] button
Click this button to change the current printer driver settings to those selected in Title.

**NOTE**
The Device Option values of those options marked with f in Title are different from what are stored and they cannot be restored.

(4) [Delete] button
Click this button to delete the settings selected in Title.
7. "Settings" Property Sheet

(5) [Modify] button
Click this button to replace the saved value with the current setting value.

(6) [Add...] button
Click this button to save the current settings.
8. "Conflict Settings Validation" Dialog Box

"Conflict Settings Validation" Dialog Box

The "Conflict Settings Validation" dialog box, like the one as shown below, appears when a setting, which conflicts with another made previously, is made on a property sheet.

![Conflict Settings Validation Dialog Box](image)

When the "Conflict Settings Validation" dialog box appears, it shows the details of the setting that conflicts with another. Go over the details and click the [OK] button to quit. This brings you back to the previous setting. Now, make a new setting that is compatible with the other one.
8. "Conflict Settings Validation" Dialog Box
1. Convenient Functions

Convenient Functions

In this chapter, you will learn how to print your document, guiding you through steps from start to end of printing. WordPad, a Windows 95 standard application, is used as an example to show the steps to follow using the Windows 95 PCL 5e version driver. Though the screen format differs from one driver to another, the procedure may be used as reference for a driver other than the Windows 95 PCL 5e. If a different procedure is applicable to a specific driver, that is included with the text.

TIPS

• Different procedures apply to start a property sheet depending on the application. This chapter is concerned only with the procedure to be used with WordPad.

• A single application may offer two or more different procedures to follow to open a property sheet. If, for example, WordPad is used on the Windows 95 PCL 5e driver, the text that follows instructs you to open a property sheet by opening the Print dialog box with "Print" in the "File" menu. Another procedure that may be used is: Open the Page Setup dialog box with "Page Setup" in the "File" menu, and then click the [Printer] button to open the Page Setup dialog box before opening a property sheet.
2. Printing More Than One Copy at a Time

Overview
This section explains how to print two or more copies of a document that has been created with an application. Most applications allow this function to be executed from the Print dialog box. The steps described in the following are used to print more than one copy and make complete sorted sets of a document by using the Sort function offered by the printer driver.

Procedure
1. Start printing from the application which has been used to create the document. Normally, printing can be started by selecting "Print" from the "File" menu.

2. The Print dialog box will appear. Check that "Digital Copier 35cpm PCL5e" is displayed for "Name" under "Printer" and click the [Properties] button.

NOTE
Some applications allow you to set Copies and Collate (Sort) in the Print dialog box. To ensure proper printing operation, however, turn OFF these items of the application and make the necessary settings in each property sheet of the printer driver.

3. The "Digital Copier 35cpm PCL5e Properties" dialog box will appear. If the "Paper" property sheet is not displayed, click the "Paper" tab.
2. Printing More Than One Copy at a Time

4. Check that the size of the document created with the application is displayed in "Paper Size."

5. In "Copies," set the number of copies to be printed.

6. In "Collate" under "Finishing," select Collated so that the printed pages are sorted into copy sets.

**TIP**

*If UnCollated or Group is selected, printed pages will be sorted into groups of the same pages.*

7. Make other settings as necessary and click the [OK] button.

8. In the Print dialog box that will then reappear, click the [OK] button. Then, the data will be transferred to the machine and printing will soon start.
3. Printing on Both Sides of the Paper

Overview

This section explains how to print a multi-page document which has been created with an application using both sides of a sheet of paper. It also shows the steps to be followed when stapling the two-sided pages.

To use this function, a Duplex Unit must be mounted on the machine.

![Print data and Printout](image)

Procedure

1. Start printing from the application which has been used to create the document. Normally, printing can be started by selecting "Print" from the "File" menu.

2. The Print dialog box will appear. Check that "Digital Copier 35cpm PCL5e" is displayed for "Name" under "Printer" and click the [Properties] button.

3. The "Digital Copier 35cpm PCL5e Properties" dialog box will appear. If the "Paper" property sheet is not displayed, click the "Paper" tab.
3. Printing on Both Sides of the Paper

4. Check that the size of the document created with the application is displayed in "Paper Size."

5. Select "Bind Long Edge" or "Bind Short Edge" from "Duplex Print."

If "Bind Long Edge" is selected, printing will be performed on both sides of each page so that the printed pages form a book when they are bound along the long edge. If "Bind Short Edge" is selected, printing will be performed on both sides of each page so that the printed pages form a book when they are bound along the short edge.

"Bind Long Edge"

1 2 1 2

"Bind Short Edge"

1 2 1
3. Printing on Both Sides of the Paper

**TIP**
The print preview shows which edge is to be bound.

6. If you want to staple the printed pages, select "Elevator Tray" for "Paper Output" and then specify "Corner" in "Staple" under "Finishing."

**NOTES**
- When "Bind Long Edge" is selected, "Short Edge" cannot be selected for punch holes.
- When "Bind Short Edge" is selected, "Long Edge" cannot be selected for punch holes.

**TIP**
To make holes in the printed pages for filing, select "Long Edge" or "Short Edge" in "Hole Punch" under "Finishing."

7. Make other settings as necessary and click the [OK] button.

8. In the Print dialog box that will then reappear, click the [OK] button. Then, the data will be transferred to the machine and printing will soon start.
4. Specifying the Exit Port

Overview

It is possible to specify a particular print exit port when the Finisher, or Mailbin Finisher is being used. The following explains how to feed printed pages into the Elevator Tray of the Mailbin Finisher.

Procedure

1. Start printing from the application which has been used to create the document. Normally, printing can be started by selecting "Print" from the "File" menu.

2. The Print dialog box will appear. Check that "Digital Copier 35cpm PCL5e" is displayed for "Name" under "Printer" and click the [Properties] button.

   NOTE
   Some applications allow you to set Copies and Collate (Sort) in the Print dialog box. To ensure proper printing operation, however, turn OFF these items of the application and make the necessary settings in each property sheet of the printer driver.

3. The "Digital Copier 35cpm PCL5e Properties" dialog box will appear. If the "Paper" property sheet is not displayed, click the "Paper" tab.
4. Check that the size of the document created with the application is displayed in "Paper Size."

4. Check for correct paper size. 5. Specify "Paper Output (exit port)."

5. Select Elevator Tray in "Paper Output." The machine preview shows the exit port selected.

6. Make other settings as necessary and click the [OK] button.

7. In the Print dialog box that will then reappear, click the [OK] button. Then, the data will be transferred to the machine and printing will soon start.

**NOTE**
The exit ports available for selection are limited depending on the paper and functions to be used. For more details, see the Operator’s Manual of the machine.
5. Specifying N-in-1 Printing

Overview

This section explains how to print two pages on one side of a sheet of paper (2in1). The same procedure is applicable when you want to print four pages on one side of a sheet of paper (4in1).

Procedure

1. Start printing from the application which has been used to create the document. Normally, printing can be started by selecting "Print" from the "File" menu.

2. The Print dialog box will appear. Check that "Digital Copier 35cpm PCL5e" is displayed for "Name" under "Printer" and click the [Properties] button.

   **NOTE**
   Some applications allow you to set Copies and Collate (Sort) in the Print dialog box. To ensure proper printing operation, however, turn OFF these items of the application and make the necessary settings in each property sheet of the printer driver.

3. The "Digital Copier 35cpm PCL5e Properties" dialog box will appear. If the "Paper" property sheet is not displayed, click the "Paper" tab.
5. Specifying N-in-1 Printing

4. Check that the size of the document created with the application is displayed in "Paper Size."

4. Check for correct paper size. 5. Select "2 in 1."

6. Set the zoom ratio.

5. Select "2 in 1" for "Form" under "Layout."

With "4 in 1," page order is either Horizontal Ascendant or Vertical Ascendant.

4. Check the page order.

"4 in 1 (Horiz.)"

1 2 3 4

"4 in 1 (Vert.)"

1 3 2 4

6. Select the print page size in "Paper" under "Layout."
5. Specifying N-in-1 Printing

7. Make other settings as necessary and click the [OK] button.

8. In the Print dialog box that will then reappear, click the [OK] button. Then, the data will be transferred to the machine and printing will soon start.

NOTES
• The 4in1 duplex printing is available only with the Digital Copier 35cpm.
• If a document that contains pages of assorted sizes and directions is printed, a void image and image overlap could result.
6. Printing in Reduced/Enlarged Size

Overview
This section explains how to reduce or enlarge the image on the document created with the application for printing.

Procedure
1. Start printing from the application which has been used to create the document. Normally, printing can be started by selecting "Print" from the "File" menu.

2. The Print dialog box will appear.
Check that "Digital Copier 35cpm PCL5e" is displayed for "Name" under "Printer" and click the [Properties] button.

NOTE
Some applications allow you to set Copies and Collate (Sort) in the Print dialog box. To ensure proper printing operation, however, turn OFF these items of the application and make the necessary settings in each property sheet of the printer driver.

3. The "Digital Copier 35cpm PCL5e Properties" dialog box will appear.
If the "Paper" property sheet is not displayed, click the "Paper" tab.
6. Printing in Reduced/Enlarged Size

4. Check that the size of the document created with the application is displayed in "Paper Size."

5. Select "Zoom" for "Form" under "Layout."

6. Select the print page size in "Paper" under "Layout."

7. Make other settings as necessary and click the [OK] button.
6. Printing in Reduced/Enlarged Size

8. In the Print dialog box that will then reappear, click the [OK] button. Then, the data will be transferred to the machine and printing will soon start.

**NOTE**

*If a paper size that does not match the paper loaded in the machine is selected, the machine will give a message that prompts you to add paper in Drawer1, entering a standby state. If Bypass has been selected, the machine will issue a message that prompts you to load paper in the manual feed port, entering a standby state.*
Convenient Functions

Chapter 4

7. Specifying Booklet Printing

Overview

This section explains how to layout and print four pages of a document to both sides of a single sheet of paper so that the printout may be folded at its center to form a booklet.

To use this function, a Duplex Unit must be mounted on the machine.

Procedure

1. Start printing from the application which has been used to create the document. Normally, printing can be started by selecting "Print" from the "File" menu.

2. The Print dialog box will appear. Check that "Digital Copier 35cpm PCL5e" is displayed for "Name" under "Printer" and click the [Properties] button.

   NOTE
   Some applications allow you to set Copies and Collate (Sort) in the Print dialog box. To ensure proper printing operation, however, turn OFF these items of the application and make the necessary settings in each property sheet of the printer driver.

3. The "Digital Copier 35cpm PCL5e Properties" dialog box will appear. If the "Paper" property sheet is not displayed, click the "Paper" tab.
7. Specifying Booklet Printing

4. Check that the size of the document created with the application is displayed in "Paper Size."

5. Select "Booklet" for "Form" under "Layout."

6. Select the print page size in "Paper" under "Layout."

7. Make other settings as necessary and click the [OK] button.

8. In the Print dialog box that will then reappear, click the [OK] button. Then, the data will be transferred to the machine and printing will soon start.

NOTE

If the original document for a print job contains a page with a different size or different direction from the others and this document is printed, a void image or overlapped image could result.
8. Using the Copy Track Function

Overview
It is possible to keep track of the number of prints produced by each account.
The particular setting made in the machine determines the number of accounts to be
controlled, either 100 or 1,000.

Procedure
The timing at which the Security dialog box appears varies with different OS. The
procedure is given for each OS.
Those for Windows 3.1 and NT 3.51 are contained in the PCL5e version.

Procedure Applicable to Windows 95
1. Start printing from the application which has been used to create the document.
   Normally, printing can be started by selecting "Print" from the "File" menu.

2. The Print dialog box will appear.
   Check that "Digital Copier 35cpm PCL5e" is displayed for "Name" under
   "Printer" and click the [Properties] button.

   NOTE
   Some applications allow you to set Copies and Collate (Sort) in the Print dialog
   box. To ensure proper printing operation, however, turn OFF these items of the
   application and make the necessary settings in each property sheet of the printer
   driver.

3. The "Digital Copier 35cpm PCL5e Properties" dialog box will appear.
   If the "Paper" property sheet is not displayed, click the "Paper" tab.
8. Using the Copy Track Function

4. Check that the size of the document created with the application is displayed in "Paper Size."

5. Select "Access Code."

The icon tells that Access Code has been selected.

5. Select "Access Job Number."

6. Make other settings as necessary and click the [OK] button.

7. The Print dialog box will reappear. Click the [OK] button.
8. Using the Copy Track Function

8. The "Access Number" dialog box will appear. Type your access number and click the [OK] button.

Specify the access number.

9. The data will then be transferred to the machine and printing will soon start.

NOTES

• When the [Cancel] button is clicked on the Security dialog box, the data is transmitted with Access Code and Lock Job not specified. It does not mean the cancellation of data transmission.

• When Access Code is used, printing may not be effected unless the access number has been correctly set. It is possible, by using the utility that comes with the NIC Board (option), to check on the personal computer screen to see whether the job has been canceled or not.
8. Using the Copy Track Function

**Procedure Applicable to Windows NT 4.0**

1. Start printing from the application that has been used to create the document. Normally, selecting "Print" from the "File" menu can start printing.

2. The Print dialog box will appear. Check that "Digital Copier 35cpm PCL 5e" is displayed for "Name" under "Printer" and click the [Properties] button.

   **NOTE**

   Some applications allow you to set Copies and Collate (Sort) in the Print dialog box. To ensure proper printing operation, however, turn OFF these items of the application and make the necessary settings in each property sheet of the printer driver.

3. The "Digital Copier 35cpm PCL 5e Properties" dialog box will appear. If the "Paper" property sheet is not displayed, click the "Paper" tab.

4. Check that the size of the document created with the application is displayed in "Paper Size."


6. Type your access number and click the [OK] button.

7. Make other settings as necessary and click the [OK] button.

8. The Print dialog box will reappear. Click the [OK] button. Then, the data will be transferred to the machine and printing will soon start.
8. Using the Copy Track Function

Procedure Applicable to Windows 3.1

1. Set up printing on the application that has been used to create the document. Normally, select "Print Setup..." from the "File" menu to set up for printing.

2. The Print Setup dialog box will appear. Check that "Digital Copier 35cpm PCL5e" is displayed for "Printer" and then click the [Options...] button.

NOTE
Some applications allow you to set Copies and Collate (Sort) in the Print dialog box. To ensure proper printing operation, however, turn OFF these items of the application and make the necessary settings in each property sheet of the printer driver.

3. The "Digital Copier 35cpm PCL5e Properties" dialog box will appear.

4. Check that the size of the document created with the application is displayed in "Paper Size."

5. Select "Access Code."

6. Make other settings as necessary and click the [OK] button.

7. The Print Setup dialog box will reappear. Click the [OK] button to go back to the application.

8. Run the print cycle from the application with which the document has been created. To run a print cycle, select [Print] from the [File] menu.

9. The Security dialog box appears. Type your access number and click the [OK] button.

10. Then, the data will be transferred to the machine and printing will soon start.

NOTE
When the [Cancel] button is clicked on the Security dialog box, the data is transmitted with Access Code and Lock Job not specified. It does not mean the cancellation of data transmission.
8. Using the Copy Track Function

Procedure Applicable to Windows NT 3.51

1. Start printing from the application that has been used to create the document. Normally, selecting "Print Setup..." from the "File" menu can start printing.

2. The Print Setup dialog box will appear. Check that "Digital Copier 35cpm PCL 5e" is displayed for "Name" under "Printer" and click the [Properties] button.

**NOTE**
Some applications allow you to set Copies and Collate (Sort) in the Print dialog box. To ensure proper printing operation, however, turn OFF these items of the application and make the necessary settings in each property sheet of the printer driver.

3. The "Digital Copier 35cpm PCL 5e Properties" dialog box will appear.

4. Check that the size of the document created with the application is displayed in "Paper Size."


6. Type your access number and click the [OK] button.

7. Make other settings as necessary and click the [OK] button.

8. The Print Setup dialog box will reappear. Click the [OK] button to go back to the application.

9. Select "Print" from the "File" menu of the application. Then, the data will be transferred to the machine and printing will soon start.
9. Printing Pages with a Distribution Number

Overview
This section explains how to print a distribution number in the background for each copy set.

**NOTE**
The orientation of the distribution number may not match that of the print image.

Procedure
1. Start printing from the application which has been used to create the document. Normally, printing can be started by selecting "Print" from the "File" menu.

2. The Print dialog box will appear. Check that "Digital Copier 35cpm PCL5e" is displayed for "Name" under "Printer" and click the [Properties] button.

**NOTE**
Some applications allow you to set Copies and Collate (Sort) in the Print dialog box. To ensure proper printing operation, however, turn OFF these items of the application and make the necessary settings in each property sheet of the printer driver.

3. The "Digital Copier 35cpm PCL5e Properties" dialog box will appear.

4. On the "Paper" property sheet, check that "Paper Size" and other items are set properly.
9. Printing Pages with a Distribution Number

5. Click the "Advanced" tab and select "Distribution Number."

6. Select the page on which to print the distribution number, either 1st Page Only or All Pages.

7. Set the image density of the distribution number for "Image Density."

8. Specify the starting distribution number.

7. The icon tells that Distribution Number has been enabled.

6. Select the page on which to print the distribution number, either 1st Page Only or All Pages.

7. Set the image density of the distribution number for "Image Density."

8. Specify the starting distribution number for "Starting Number."

9. Make other settings as necessary and click the [OK] button.

10. In the Print dialog box that will then reappear, click the [OK] button. Then, the data will be transferred to the machine and printing will soon start.
Overview
This section explains how to print pages with text (e.g. Confidential, Draft) in the background.

Procedure
1. Start printing from the application which has been used to create the document. Normally, printing can be started by selecting "Print" from the "File" menu.

2. The Print dialog box will appear. Check that "Digital Copier 35cpm PCL5e" is displayed for "Name" under "Printer" and click the [Properties] button.

   **NOTE**
   Some applications allow you to set Copies and Collate (Sort) in the Print dialog box. To ensure proper printing operation, however, turn OFF these items of the application and make the necessary settings in each property sheet of the printer driver.

3. The "Digital Copier 35cpm PCL5e Properties" dialog box will appear.

4. On the "Paper" property sheet, check that "Paper Size" and other items are set properly.
10. Printing Pages with Watermarks

5. Click the "Advanced" tab and select "Water Mark."

Allows you to view a print sample.

6. Select "Watermark." 6. Select the page on which to print the watermark

7. Select the desired watermark.

8. Specify the editing function for the watermark

The icon tells that Watermark has been enabled.

6. Select the page on which to print the watermark, either 1st Page Only or All Pages.

7. Select the desired watermark.
8. If you do not find an appropriate watermark among those available or if you want to change the position or style of an existing watermark, click the [Edit] button, which opens the "Watermark" dialog box. Specify "Text" and text style, "Angle," and "Position."

**TIP**
For the position, specify the distance from the center. The + direction in X is toward the right and the + direction in Y is upward.

9. After the settings have been made, click the [OK] button to close the dialog box.

10. Make other settings as necessary and click the [OK] button.

11. In the Print dialog box that will then reappear, click the [OK] button. Then, the data will be transferred to the machine and printing will soon start.

**NOTE**
This function may not be effective in some applications.
11. Printing on OHP Transparencies

Overview
This section explains how to insert a sheet of paper (interleaf) between sheets of OHP transparencies when printing on sheets of OHP transparencies. This interleaf may be left blank or have the same data printed on it as the OHP transparencies.

Procedure
1. Start printing from the application which has been used to create the document. Normally, printing can be started by selecting "Print" from the "File" menu.

2. The Print dialog box will appear.
   Check that "Digital Copier 35cpm PCL5e" is displayed for "Name" under "Printer" and click the [Properties] button.

   **NOTE**
   Some applications allow you to set Copies and Collate (Sort) in the Print dialog box. To ensure proper printing operation, however, turn OFF these items of the application and make the necessary settings in each property sheet of the printer driver.

3. The "Digital Copier 35cpm PCL5e Properties" dialog box will appear.

4. On the "Paper" property sheet, check that "Paper Size" and other items are set properly.
11. Printing on OHP Transparencies

5. Click the "Advanced" tab and select "OHP Interleaving."

6. Select the paper source for OHP transparencies under "OHP Paper Source."

7. Select the paper source for interleaves under "Interleaving Paper Source."

8. Select the "with Image" box if you want the OHP data printed on the interleaves.

9. Make other settings as necessary and click the [OK] button.

10. In the Print dialog box that will then reappear, click the [OK] button. Then, the data will be transferred to the machine and printing will soon start.
12. Adding a Cover to Each Copy Set

Overview

This section explains how to add a front cover and/or a back cover to each of your copy sets. Four different modes are available to choose from. Select the appropriate one according to your needs.

Procedure

1. Start printing from the application which has been used to create the document. Normally, printing can be started by selecting "Print" from the "File" menu.

2. The Print dialog box will appear.
   Check that "Digital Copier 35cpm PCL5e" is displayed for "Name" under "Printer" and click the [Properties] button.

   **NOTE**
   Some applications allow you to set Copies and Collate (Sort) in the Print dialog box. To ensure proper printing operation, however, turn OFF these items of the application and make the necessary settings in each property sheet of the printer driver.

3. The "Digital Copier 35cpm PCL5e Properties" dialog box will appear.

4. On the "Paper" property sheet, check that "Paper Size" and other items are set properly.
12. Adding a Cover to Each Copy Set

5. Click the "Advanced" tab and select "Cover Mode."

Shows the paper source for text and that for front/back cover.


7. Select the paper source for front cover.

8. Select this box if you also want a back cover.

8. Select this box if you want data printed on the front cover.

The icon tells that Cover Mode has been enabled.

6. Select the paper source for text under "Paper Source."

7. Select the paper source for the front/back cover under "Front Cover Paper Source."

8. Select the "with Image" and/or "with Back Cover" boxes if you want data printed on the front cover and if you want also a back cover.

9. Make other settings as necessary and click the [OK] button.

10. In the Print dialog box that will then reappear, click the [OK] button. Then, the data will be transferred to the machine and printing will soon start.
13. Using the Lock Job Function

Overview

Lock Job allows you to keep a particular document confidential and that document can be printed only when a password is entered on the machine.

Procedure on the Printer Drive Side

The timing at which the Security dialog box appears varies with different OS. The procedure is given for each OS.

Those for Windows 3.1 and NT 3.51 are contained in the PCL5e version.

NOTE
Slightly different procedures are used to access each screen among PCL5e, PCL6, and PS.

Procedure Applicable to Windows 95

1. Start printing from the application which has been used to create the document. Normally, printing can be started by selecting "Print" from the "File" menu.

2. The Print dialog box will appear.
   Check that "Digital Copier 35cpm PCL5e" is displayed for "Name" under "Printer" and click the [Properties] button.

NOTE
Some applications allow you to set Copies and Collate (Sort) in the Print dialog box. To ensure proper printing operation, however, turn OFF these items of the application and make the necessary settings in each property sheet of the printer driver.
3. The "Digital Copier 35cpm PCL5e Properties" dialog box will appear.

4. On the "Paper" property sheet, check that "Paper Size" and other items are set properly.

5. Click the "Advanced" tab and select "Lock Job."

6. Select "Lock Job."
   The icon tells that Lock Job has been enabled.

6. Make other settings as necessary and click the [OK] button.

7. The Print dialog box will appear. Click the [OK] button.
13. Using the Lock Job Function

8. The "Access Number" dialog box will appear. Type your password and click the [OK] button.

9. The data will then be transferred to the machine. Printing will not, however, start at this point yet.

**NOTE**
When the [Cancel] button is clicked in the Windows 95/3.1 version driver, it means that the data is transmitted with Access Code and Lock Job not specified. It does not mean the cancellation of data transmission.
13. Using the Lock Job Function

Procedure Applicable to Windows NT 4.0

1. Start printing from the application that has been used to create the document. Normally, selecting "Print" from the "File" menu can start printing.

2. The Print dialog box will appear. Check that "Digital Copier 35cpm PCL 5e" is displayed for "Name" under "Printer" and click the [Properties] button.

NOTE
Some applications allow you to set Copies and Collate (Sort) in the Print dialog box. To ensure proper printing operation, however, turn OFF these items of the application and make the necessary settings in each property sheet of the printer driver.

3. The "Digital Copier 35cpm PCL 5e Properties" dialog box will appear. If the "Paper" property sheet is not displayed, click the "Paper" tab.

4. Check that the "Paper Size" and other items are properly set on the "Paper" property sheet.

5. Click the "Advanced" tab and select "Lock Job." The Security dialog box will appear.

6. Type your password and click the [OK] button.

7. Make other settings as necessary and click the [OK] button.

8. The Print dialog box will reappear. Click the [OK] button. Then, the data will be transferred to the machine. Printing will not, however, start at this point yet.
13. Using the Lock Job Function

Procedure Applicable to Windows 3.1

1. Set up printing on the application that has been used to create the document. Normally, select "Print Setup..." from the "File" menu to set up for printing.

2. The Print Setup dialog box will appear. Check that "Digital Copier 35cpm PCL5e" is displayed for "Name" under "Printer" and click the [Options...] button.

   **NOTE**
   Some applications allow you to set Copies and Collate (Sort) in the Print dialog box. To ensure proper printing operation, however, turn OFF these items of the application and make the necessary settings in each property sheet of the printer driver.

3. The "Digital Copier 35cpm PCL5e Properties" dialog box will appear.

4. Check that the size of the document created with the application is displayed in "Paper Size."

5. Click the [Advanced] button and select "Lock Job."

6. Click the [OK] button to go back to the Paper property sheet.

7. Make other settings as necessary and click the [OK] button.

8. The Print Setup dialog box will reappear. Click the [OK] button to go back to the application.

9. Run the print cycle from the application with which the document has been created. To run a print cycle, select [Print] from the [File] menu.

10. The Security dialog box appears. Type your password and click the [OK] button.

11. Then, the data is transferred to the machine. At this time, however, printing does not immediately start.

   **NOTE**
   When the [Cancel] button is clicked on the Security dialog box, the data is transmitted with Access Code and Lock Job not specified. It does not mean the cancellation of data transmission.
4-38

13. Using the Lock Job Function

Procedure Applicable to Windows NT 3.51

1. Start printing from the application that has been used to create the document. Normally, selecting "Print Setup..." from the "File" menu can start printing.

2. The Print Setup dialog box will appear. Check that "Digital Copier 35cpm PCL 5e" is displayed for "Name" under "Printer" and click the [Properties] button.

NOTE
Some applications allow you to set Copies and Collate (Sort) in the Print dialog box. To ensure proper printing operation, however, turn OFF these items of the application and make the necessary settings in each property sheet of the printer driver.

3. The "Digital Copier 35cpm PCL 5e Properties" dialog box will appear.

4. Check that the size of the document created with the application is displayed in "Paper Size."

5. Click the "Advanced" tab and select "Lock Job." The Security dialog box will appear.

6. Type your password and click the [OK] button.

7. Click the [OK] button to go back to the Paper property sheet.

8. Make other settings as necessary and click the [OK] button.

9. The Print Setup dialog box will reappear. Click the [OK] button to go back to the application.

10. Select “Print” from the “File” menu of the application. This shows the Print dialog box. Now, click the [OK] button. Then, the data will be transferred to the machine.

11. The Print dialog box will appear. Clicking the [OK] button causes the data to be transferred to the machine. Printing will not, however, start at this point yet.
13. Using the Lock Job Function

Procedure on the Machine Side

Unlocking a Job

After the data has been transferred to the machine, operate the machine to start printing.

1. Touch the [Job List] key.

2. Touch the [Unlock] key.
13. Using the Lock Job Function

3. Enter the password.

4. Printing will start.

**TIPS**
- If there is a job that has previously been stored as a locked job, that job is first printed.
- There is no need of selecting a job or jobs to be unlocked. All locked jobs having the same password are unlocked.
13. Using the Lock Job Function

Deleting a Job
After the data has been transferred to the machine, it is deleted without being printed.

1. Touch the [Job List] key.

![Image of a device interface]

2. Touch the [Delete] key.

![Image of a device interface]
13. Using the Lock Job Function

3. Select the job to be deleted.

4. Touch the [Exit] key.

**TIP**
To cancel the deletion, touch the [No] key, then [Exit] key.

5. This deletes the job from the job list.

**TIPS**
- If there is a job that has previously been stored as a locked job, that job is first printed.
- No password is necessary to delete a job.
14. Using the Settings Function

Overview
Frequently used groupings of print settings can be stored and called up as necessary for application in actual print jobs.

Procedure
Settings may be stored, called up, deleted, and modified.
Storing, deleting, and modifying the setting data can be made from the printer icon property opened from the Printers window. The following steps are, however, concerned with the procedures when the property is opened from the application.
14. Using the Settings Function

Using the Settings Stored for a Current Print Job

1. Start printing from the application which has been used to create the document. Normally, printing can be started by selecting "Print" from the "File" menu.

2. The Print dialog box will appear. Check that "Digital Copier 35cpm PCL5e" is displayed for "Name" under "Printer" and click the [Properties] button.

**NOTE**
Some applications allow you to set Copies and Collate (Sort) in the Print dialog box. To ensure proper printing operation, however, turn OFF these items of the application and make the necessary settings in each property sheet of the printer driver.

3. The "Digital Copier 35cpm PCL5e Properties" dialog box will appear.

4. Click the "Settings" tab.

5. Click the down-arrow "▼" of Title and, from the menu that will appear, select the title name to be used.

6. Click the [Restore] button. The printer controller then reads the setting data. The details of the setting data read can be checked on each property sheet or the Setting screen.

**NOTE**
The options that have a different status from that of the Device Option of the currently used driver are marked with ☒ and they cannot be restored.

7. Click the [OK] button.

8. In the Print dialog box that will then reappear, click the [OK] button. Then, the data will be transferred to the machine and printing will soon start.
14. Using the Settings Function

Storing Settings

1. Start printing from the application which has been used to create the document. Normally, printing can be started by selecting "Print" from the "File" menu.

2. The Print dialog box will appear. Check that "Digital Copier 35cpm PCL5e" is displayed for "Name" under "Printer" and click the [Properties] button.

3. The "Digital Copier 35cpm PCL5e Properties" dialog box will appear.


5. Type the title name to be stored in the Title box and click the [Add...] button.

6. Click the [OK] button.

7. The Print dialog box will then reappear. To start printing immediately, click the [OK] button. Then, the data will be transferred to the machine and printing will soon start. If printing is not done for now, click the [Cancel] button.

NOTE

Some applications allow you to set Copies and Collate (Sort) in the Print dialog box. To ensure proper printing operation, however, turn OFF these items of the application and make the necessary settings in each property sheet of the printer driver.

NOTE

Settings can be stored from the printer icon property sheet opened from the Printers window. The same procedure also applies when the printer icon property sheet is used; however, be sure to click the [Cancel] button to close the property sheet. If it is closed by clicking the [OK] button, the settings will be the default values when the property sheet is accessed from the application.
14. Using the Settings Function

Deleting Settings Which Have Been Stored

1. Start printing from the application which has been used to create the document. Normally, printing can be started by selecting "Print" from the "File" menu.

2. The Print dialog box will appear. Check that "Digital Copier 35cpm PCL5e" is displayed for "Name" under "Printer" and click the [Properties] button.

**NOTE**
Some applications allow you to set Copies and Collate (Sort) in the Print dialog box. To ensure proper printing operation, however, turn OFF these items of the application and make the necessary settings in each property sheet of the printer driver.

3. The "Digital Copier 35cpm PCL5e Properties" dialog box will appear.

4. Click the "Settings" tab.

5. Click the down arrow "▼" of Title and, from the menu that will appear, select the title name to be used.

6. Click the [Delete] button. This deletes the specified title name.

**NOTE**
The options that have a different status from that of the Device Option of the currently used driver are marked with ☉, but they can be deleted after selection.

7. Click the [OK] button.
14. Using the Settings Function

8. In the Print dialog box that will then reappear, click the [Cancel] button.

**NOTE**

*Settings can be deleted from the printer icon property sheet opened from the Printers window.*
4-48

14. Using the Settings Function

Modifying Settings Which Have Been Stored

1. Start printing from the application which has been used to create the document. Normally, printing can be started by selecting "Print" from the "File" menu.

2. The Print dialog box will appear. Check that "Digital Copier 35cpm PCL5e" is displayed for "Name" under "Printer" and click the [Properties] button.

   **NOTE**
   Some applications allow you to set Copies and Collate (Sort) in the Print dialog box. To ensure proper printing operation, however, turn OFF these items of the application and make the necessary settings in each property sheet of the printer driver.

3. The "Digital Copier 35cpm PCL5e Properties" dialog box will appear.


5. Click the down arrow "▼" of Title and, from the menu that will appear, select the title name to be modified.

6. Click the [Modify] button. The setting data is rewritten.

7. Click the [OK] button.

8. The Print dialog box will then reappear. To start printing immediately, click the [OK] button. Then, the data will be transferred to the machine and printing will soon start. If printing is not done for now, click the [Cancel] button.

   **NOTE**
   Settings can be modified from the printer icon property sheet opened from the Printers window.
Chapter 5

Troubleshooting
1. Troubleshooting

Unable to Print

This chapter explains about the troubleshooting procedures for possible malfunctions. Perform the troubleshooting procedures given below in that order when the machine is unable to print even if you execute a print command from your computer.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>A message appears on the computer screen, saying to the effect that &quot;no printer is connected,&quot; &quot;no paper is loaded,&quot; or &quot;LPT1 write error.&quot;</td>
<td>An error is present in the machine.</td>
<td>Check the control panel of the machine. If an error is displayed, identify the error and take the necessary action by referring to &quot;Error List&quot; on p. 5-9.</td>
</tr>
<tr>
<td>The interface cable that connects the printer controller to the machine is disconnected.</td>
<td>Check that the printer controller connection cable is plugged into the machine.</td>
<td></td>
</tr>
<tr>
<td>The printer cable or network cable is disconnected.</td>
<td>Check that the printer cable or network cable is connected properly to the computer and printer controller.</td>
<td></td>
</tr>
<tr>
<td>Printing does not start despite the completion of printing setup on the computer.</td>
<td>An error is present in the machine.</td>
<td>Check the control panel of the machine. If an error is displayed, identify the error and take the necessary action by referring to &quot;Error List&quot; on p. 5-9.</td>
</tr>
<tr>
<td>The interface cable that connects the printer controller to the machine is disconnected.</td>
<td>Check that the printer controller connection cable is plugged into the machine.</td>
<td></td>
</tr>
<tr>
<td>The printer cable or network cable is disconnected.</td>
<td>Check that the printer cable or network cable is connected properly to the computer and printer controller.</td>
<td></td>
</tr>
<tr>
<td>The printer driver selected for printing is not for the Digital Copier 25cpm/Digital Copier 35cpm.</td>
<td>Check the printer name selected in the &quot;Print&quot; dialog box.</td>
<td></td>
</tr>
<tr>
<td>A print job yet to be processed is loaded in the machine, causing the printer to wait.</td>
<td>Refer to the Job List on the machine control panel to check for print order.</td>
<td></td>
</tr>
</tbody>
</table>
## 1. Troubleshooting

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Continued from the previous page (Printing does not start despite the completion of printing setup on the computer.)</td>
<td>The print job is locked.</td>
<td>Refer to the Job List on the machine control panel to see if the print job in question is locked. If so, unlock it.</td>
</tr>
<tr>
<td></td>
<td>The connection of the printer controller to the network has not been established.</td>
<td>Consult the network administrator.</td>
</tr>
<tr>
<td></td>
<td>The print job was canceled.</td>
<td>Check the control panel of the machine. If an error is displayed, identify the error and take the necessary action by referring to &quot;Error List&quot; on p. 5-9.</td>
</tr>
<tr>
<td></td>
<td>Machine memory space available is not sufficient.</td>
<td>Add the machine memory to expand its space.</td>
</tr>
<tr>
<td></td>
<td>If the copy track function is enabled, an illegal access number might have been entered.</td>
<td>Enter the correct access number.</td>
</tr>
<tr>
<td></td>
<td>Multiple copy sets are mistakenly sorted and stapled together as a single large set.</td>
<td>The settings in certain DTP software applications may conflict with the printer driver settings.</td>
</tr>
<tr>
<td></td>
<td>A large number of copies are mistakenly printed.</td>
<td>The settings in certain DTP software applications may conflict with the printer driver settings.</td>
</tr>
<tr>
<td></td>
<td>A document containing more than 40 pages cannot be printed.</td>
<td>The maximum number of document pages that can be stored in the standard memory is 40.</td>
</tr>
</tbody>
</table>
## Troubleshooting

If the problem persists even after these checks have been made, refer to the documentation provided for the machine.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>A PS error print is output.</td>
<td>Some applications allow you to select either &quot;Binary&quot; or &quot;ASCII&quot; mode when the PS driver is being used. A PS error could result if an attempt is made to print in the &quot;Binary&quot; mode.</td>
<td>Select the &quot;ASCII&quot; mode.</td>
</tr>
</tbody>
</table>

If the problem persists even after these checks have been made, refer to the documentation provided for the machine.
1. Troubleshooting

Unable to Make Correct Settings / Unable to Print Exactly as Set

Perform the troubleshooting procedures given below in that order when you cannot make proper settings in the printer driver or when the print results do not represent what has been set.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unable to select an item in the printer driver.</td>
<td>Some functions cannot be combined.</td>
<td>Do not select items which are dimmed or marked with ☹.</td>
</tr>
<tr>
<td>The &quot;Conflict Setting Validation&quot; dialog box is</td>
<td>An illegal combination of functions has been made.</td>
<td>Check for combination and make a correct combination of functions.</td>
</tr>
<tr>
<td>displayed on the computer screen.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unable to print exactly as set.</td>
<td>Incorrect settings are made.</td>
<td>Check the setting for each item of the printer driver.</td>
</tr>
<tr>
<td>The watermark cannot be printed.</td>
<td>The watermark is not correctly set.</td>
<td>Check the watermark setting.</td>
</tr>
<tr>
<td></td>
<td>The &quot;Darkness&quot; setting of the watermark is low.</td>
<td>Check the &quot;Darkness&quot; setting of the watermark.</td>
</tr>
<tr>
<td>Unable to specify Staple.</td>
<td>Staple can be specified only when &quot;Finisher&quot; or &quot;Mailbin Finisher&quot; is</td>
<td>Select &quot;Finisher&quot; or &quot;Mailbin Finisher&quot; for &quot;Finisher&quot; on the &quot;Device</td>
</tr>
<tr>
<td></td>
<td>selected for &quot;Finisher&quot; on the &quot;Device Option&quot; property sheet and &quot;Elevator Tray&quot; is selected</td>
<td>Option&quot; property sheet, and select &quot;Elevator Tray&quot; for &quot;Paper Output&quot; on</td>
</tr>
<tr>
<td></td>
<td>is selected for &quot;Paper Output&quot; on the &quot;Paper&quot; property sheet.</td>
<td>the &quot;Paper&quot; property sheet.</td>
</tr>
<tr>
<td></td>
<td>No stapling can be effected if the paper size is any but Ledger, Legal,</td>
<td>Check the setting of the paper size, paper source, exit port, Booklet,</td>
</tr>
<tr>
<td></td>
<td>Letter, A4, and A3, the paper source is the manual feed port, any exit port</td>
<td>OHP Interleaving is specified, or UnCollated is specified.</td>
</tr>
<tr>
<td></td>
<td>is selected but the Elevator Tray, Booklet is specified, OHP Interleaving</td>
<td></td>
</tr>
<tr>
<td></td>
<td>is specified, or UnCollated is specified.</td>
<td></td>
</tr>
</tbody>
</table>
### 1. Troubleshooting

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unable to staple properly.</td>
<td>No stapling can be effected if the type of paper is thick paper or OHP transparencies.</td>
<td>Check the type of paper.</td>
</tr>
<tr>
<td></td>
<td>No stapling can be effected if the number of prints to be made exceeds 50 or the original document contains pages of different sizes.</td>
<td>Check the number of prints to be made.</td>
</tr>
<tr>
<td>Unable to specify Hole Punch.</td>
<td>Either a Finisher or Mailbin Finisher must be mounted to enable setting Hole Punch. Hole Punch can be specified only if Finisher or Mailbin Finisher is selected in Device Option.</td>
<td>Select Finisher or Mailbin Finisher in Device Option.</td>
</tr>
<tr>
<td></td>
<td>Hole Punch cannot be specified if Booklet or OHP Interleaving is specified.</td>
<td>Check the setting of Booklet and OHP Interleaving.</td>
</tr>
<tr>
<td>Unable to effect Hole Punch.</td>
<td>No holes can be made if the type of paper is thick paper or OHP transparencies.</td>
<td>Check the type of paper.</td>
</tr>
<tr>
<td></td>
<td>Prints can at times be fed out without being punched if the direction of the paper loaded in the paper source is not appropriate.</td>
<td>Check the direction of the paper.</td>
</tr>
<tr>
<td>Unable to print image properly.</td>
<td>Machine memory space available is not sufficient.</td>
<td>Add the machine memory to expand its space or simplify the image to reduce the amount of data handled.</td>
</tr>
<tr>
<td>Unable to specify the exit port</td>
<td>No exit port can be specified if the paper size is A6 or B6, or OHP Interleaving is specified.</td>
<td>Check the setting of the paper size and OHP Interleaving.</td>
</tr>
</tbody>
</table>
## 1. Troubleshooting

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unable to properly feed prints out to the specified port.</td>
<td>No prints are fed into the Elevator Tray or Mailbin 1 to 5 if the paper type is thick paper or OHP transparencies, or the paper size is A5 or smaller.</td>
<td>Check the paper type and paper size.</td>
</tr>
<tr>
<td>Paper is not fed from the specified paper source.</td>
<td>Paper is not be fed from the specified paper source if that paper source is loaded with paper of a different size and direction.</td>
<td>Load the paper source with paper of the appropriate size and in the appropriate direction.</td>
</tr>
<tr>
<td>Watermark is not printed.</td>
<td>Watermark may not be printed in graphics applications.</td>
<td>No watermark can be printed in this case.</td>
</tr>
<tr>
<td>Unable to print exactly as set.</td>
<td>The paper size, paper direction, and other settings made on the application takes precedence over those made in the driver.</td>
<td>Make correct settings on the application.</td>
</tr>
</tbody>
</table>
1. Troubleshooting

Poor Print Quality

Perform these troubleshooting procedures when you get poor print quality.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shades of gray are not clear.</td>
<td>Halftone setting is improperly set.</td>
<td>Check the setting made in &quot;Halftone&quot; in the &quot;Graphics&quot; property sheet.</td>
</tr>
</tbody>
</table>

If the problem persists even after these checks have been made, refer to the documentation provided for the machine.
Error List

When an error occurs, the machine control panel gives the message of "Printer controller failure -> 18xx."
The table below lists the meanings of different error codes, together with the appropriate remedial procedures. Should an error occur, identify the detail of the error and take the necessary action.

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1810</td>
<td>Parallel interface being initialized.</td>
<td>Turn OFF the power, then turn it ON again. If the error persists, consult your Tech. Rep.</td>
</tr>
<tr>
<td>1811</td>
<td>NIC interface being initialized.</td>
<td></td>
</tr>
<tr>
<td>1812</td>
<td>DL controller internal logic circuitry being initialized.</td>
<td></td>
</tr>
<tr>
<td>1813</td>
<td>Printer functions being started.</td>
<td></td>
</tr>
<tr>
<td>1820</td>
<td>NVRAM error Issued when a fault is found in the condition of the setting values saved in the NVRAM of the printer controller.</td>
<td>Turn OFF the power, then turn it on again. If the error persists, consult your Tech. Rep.</td>
</tr>
<tr>
<td>1821</td>
<td>Parallel interface error</td>
<td></td>
</tr>
<tr>
<td>1822</td>
<td>NIC function level error</td>
<td></td>
</tr>
<tr>
<td>1823</td>
<td>NIC error</td>
<td></td>
</tr>
<tr>
<td>1880-18FF</td>
<td>Informs that part of the printer controller functions have been disabled because of a fatal error detected.</td>
<td>Turn OFF the power, then turn it ON again. If the error persists, consult your Tech. Rep.</td>
</tr>
</tbody>
</table>

This manual contains the specifications for the printer controller. Refer to the documentation provided for the machine for the machine specifications.
1. Troubleshooting
## Function Combination Matrix

<table>
<thead>
<tr>
<th>Paper Source</th>
<th>Finishing</th>
<th>Layout</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Drawer2 - Drawer5, LCC</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Drawer1[MPC]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bypass</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Uncollated</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Collated</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Group</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Staple</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hole Punch</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1-sided 1in1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2-sided 1in1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1-sided 2in1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2-sided 2in1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1-sided 4in1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2-sided 4in1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zoom</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Booklet</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Distribution Number</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Watermark</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OHP Interleaving</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cover mode</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- : The combination is possible.
× : The combination is impossible.
(The settings made are rejected.)
△ : Rejects the use of special paper. If special paper is selected, the machine automatically reselects another paper source loaded with an appropriate type of paper.
## 1. Function Combination Matrix

<table>
<thead>
<tr>
<th>Paper Source</th>
<th>Advanced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto</td>
<td></td>
</tr>
<tr>
<td>Drawer2 ~ Drawer5, LCC</td>
<td></td>
</tr>
<tr>
<td>Drawer1 [MPC]</td>
<td></td>
</tr>
<tr>
<td>Bypass</td>
<td>x</td>
</tr>
<tr>
<td>Uncollated</td>
<td>x</td>
</tr>
<tr>
<td>Collated</td>
<td>x</td>
</tr>
<tr>
<td>Group</td>
<td>x</td>
</tr>
<tr>
<td>Staple</td>
<td></td>
</tr>
<tr>
<td>Hole Punch</td>
<td></td>
</tr>
<tr>
<td>Duplex Print/Layout</td>
<td></td>
</tr>
<tr>
<td>1-sided 1in1</td>
<td></td>
</tr>
<tr>
<td>2-sided 1in1</td>
<td></td>
</tr>
<tr>
<td>1-sided 2in1</td>
<td></td>
</tr>
<tr>
<td>2-sided 2in1</td>
<td></td>
</tr>
<tr>
<td>1-sided 4in1</td>
<td></td>
</tr>
<tr>
<td>2-sided 4in1</td>
<td></td>
</tr>
<tr>
<td>Zoom</td>
<td></td>
</tr>
<tr>
<td>Booklet</td>
<td></td>
</tr>
</tbody>
</table>

| Distribution Number        |          |
| Watermark                  |          |
| OHP Interleafing           |          |
| Cover mode                 |          |

### Advanced Functions
- [x] Distribution Number
- [ ] Watermark
- [ ] OHP Interleafing
- [ ] Cover mode
## 2. Preview Listing

### [Paper Preview]

<table>
<thead>
<tr>
<th>Value Defined for Print Setting Item</th>
<th>Screen Specifications</th>
<th>Value Defined for Print Setting Item</th>
<th>Screen Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Portrait</td>
<td><img src="image1.png" alt="Screen Specifications" /></td>
<td>LandScape</td>
<td><img src="image2.png" alt="Screen Specifications" /></td>
</tr>
<tr>
<td>HolePunch= Long Edge Portrait</td>
<td><img src="image3.png" alt="Screen Specifications" /></td>
<td>HolePunch= Short Edge Portrait</td>
<td><img src="image4.png" alt="Screen Specifications" /></td>
</tr>
<tr>
<td>HolePunch= Long Edge Landscape</td>
<td><img src="image5.png" alt="Screen Specifications" /></td>
<td>HolePunch= Short Edge Landscape</td>
<td><img src="image6.png" alt="Screen Specifications" /></td>
</tr>
<tr>
<td>DuplexPrint= Bind Long Edge Portrait</td>
<td><img src="image7.png" alt="Screen Specifications" /></td>
<td>DuplexPrint= Bind Short Edge Portrait</td>
<td><img src="image8.png" alt="Screen Specifications" /></td>
</tr>
<tr>
<td>Value Defined for Print Setting Item</td>
<td>Screen Specifications</td>
<td>Value Defined for Print Setting Item</td>
<td>Screen Specifications</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-----------------------</td>
<td>-------------------------------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>DuplexPrint= Bind Short Edge Landscape</td>
<td><img src="4608P148CA" alt="Image" /></td>
<td>DuplexPrint= Bind Long Edge Landscape</td>
<td><img src="4608P149CA" alt="Image" /></td>
</tr>
<tr>
<td>Staple= Corner Portrait</td>
<td><img src="4608P071CA" alt="Image" /></td>
<td>Staple= Corner Landscape</td>
<td><img src="4608P150CA" alt="Image" /></td>
</tr>
<tr>
<td>2in1 Portrait</td>
<td><img src="4608P072CA" alt="Image" /></td>
<td>2in1 Landscape</td>
<td><img src="4608P182CA" alt="Image" /></td>
</tr>
<tr>
<td>4in1(Vert) Portrait</td>
<td><img src="4608P142CA" alt="Image" /></td>
<td>4in1(Horiz) Portrait</td>
<td><img src="4608P141CA" alt="Image" /></td>
</tr>
</tbody>
</table>
## Appendix A

### 2. Preview Listing

<table>
<thead>
<tr>
<th>Value Defined for Print Setting Item</th>
<th>Screen Specifications</th>
<th>Value Defined for Print Setting Item</th>
<th>Screen Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>4in1 (vert) Landscape</td>
<td>![Image] 4608P073CA</td>
<td>4in1 (Horiz) Landscape</td>
<td>![Image] 4608P074CA</td>
</tr>
<tr>
<td>Booklet Portrait</td>
<td>![Image] 4608P075CA</td>
<td>Booklet Landscape</td>
<td>![Image] 4608P184CA</td>
</tr>
<tr>
<td>Watermark</td>
<td>![Image] 4608P076CA</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Machine Preview

<table>
<thead>
<tr>
<th>Value Defined for Print Setting Item</th>
<th>Screen Specifications</th>
<th>Value Defined for Print Setting Item</th>
<th>Screen Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installed Drawer= Drawer1, 2</td>
<td><img src="460P077CD" alt="Image" /></td>
<td>Installed Drawer= Drawer1, 2, 3</td>
<td><img src="460P078CD" alt="Image" /></td>
</tr>
<tr>
<td>Installed Drawer= Drawer1, 2, 3, 4</td>
<td><img src="460P079CD" alt="Image" /></td>
<td>Installed Drawer= Drawer1, 2, 3, 4, 5</td>
<td><img src="460P080CD" alt="Image" /></td>
</tr>
<tr>
<td>Installed Drawer= Drawer1, 2 + LCC</td>
<td><img src="460P081CD" alt="Image" /></td>
<td>Installed Drawer= Drawer1, 2, 3 + LCC</td>
<td><img src="460P082CD" alt="Image" /></td>
</tr>
<tr>
<td>Duplex unit= Installed</td>
<td><img src="460P083CD" alt="Image" /></td>
<td>Finisher= Job Tray</td>
<td><img src="460P084CD" alt="Image" /></td>
</tr>
</tbody>
</table>
### 2. Preview Listing

<table>
<thead>
<tr>
<th>Value Defined for Print Setting Item</th>
<th>Screen Specifications</th>
<th>Value Defined for Print Setting Item</th>
<th>Screen Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Finisher= ShiftTray</td>
<td>![Image of ShiftTray]</td>
<td>Finisher= Finisher</td>
<td>![Image of Finisher]</td>
</tr>
<tr>
<td></td>
<td>4608P085CD</td>
<td></td>
<td>4608P086CD</td>
</tr>
<tr>
<td>Finisher= MailBin Finisher</td>
<td>![Image of MailBin]</td>
<td></td>
<td>![Image of Finisher]</td>
</tr>
<tr>
<td></td>
<td>4608P087CD</td>
<td></td>
<td>4608P088CD</td>
</tr>
</tbody>
</table>
## Setting Preview

<table>
<thead>
<tr>
<th>Value Defined for Print Setting Item</th>
<th>Screen Specifications</th>
<th>Value Defined for Print Setting Item</th>
<th>Screen Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Code=On</td>
<td>Zoom</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><img src="image1" alt="Access Code=On" /></td>
<td><img src="image2" alt="Zoom" /></td>
<td></td>
</tr>
<tr>
<td>Cover Mode</td>
<td>Cover Mode (With Image)</td>
<td><img src="image3" alt="Cover Mode (With Image)" /></td>
<td><img src="image4" alt="Cover Mode (With Image)" /></td>
</tr>
<tr>
<td><img src="image5" alt="Cover Mode" /></td>
<td><img src="image6" alt="Cover Mode (With Image)" /></td>
<td><img src="image7" alt="Cover Mode (With Image)" /></td>
<td><img src="image8" alt="Cover Mode (With Image)" /></td>
</tr>
<tr>
<td>Cover Mode (With Back Cover)</td>
<td>Cover Mode (With Image with Back Cover)</td>
<td><img src="image9" alt="Cover Mode (With Image with Back Cover)" /></td>
<td><img src="image10" alt="Cover Mode (With Image with Back Cover)" /></td>
</tr>
<tr>
<td><img src="image11" alt="Cover Mode (With Back Cover)" /></td>
<td><img src="image12" alt="Cover Mode (With Image with Back Cover)" /></td>
<td><img src="image13" alt="Cover Mode (With Image with Back Cover)" /></td>
<td><img src="image14" alt="Cover Mode (With Image with Back Cover)" /></td>
</tr>
<tr>
<td>OHP Interleaving</td>
<td>OHP Interleaving (With Image)</td>
<td><img src="image15" alt="OHP Interleaving (With Image)" /></td>
<td><img src="image16" alt="OHP Interleaving (With Image)" /></td>
</tr>
<tr>
<td><img src="image17" alt="OHP Interleaving" /></td>
<td><img src="image18" alt="OHP Interleaving (With Image)" /></td>
<td><img src="image19" alt="OHP Interleaving (With Image)" /></td>
<td><img src="image20" alt="OHP Interleaving (With Image)" /></td>
</tr>
</tbody>
</table>
## 2. Preview Listing

<table>
<thead>
<tr>
<th>Value Defined for Print Setting Item</th>
<th>Screen Specifications</th>
<th>Value Defined for Print Setting Item</th>
<th>Screen Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Distribution Number (Only 1st Page)</td>
<td>Distribution Number (All Page)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4608P096CA</td>
<td></td>
<td>4608P185CA</td>
</tr>
<tr>
<td>Watermark (Only 1st Page)</td>
<td>Watermark (All Page)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4608P098CA</td>
<td></td>
<td>4608P097CA</td>
</tr>
<tr>
<td>Lock Job</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4608P095CA</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
3. Specifications

### Specifications

The basic specifications for Pi3500 are given below.

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Model Name</strong></td>
<td>Pi3500</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Optional printer controller mounted externally on back of machine</td>
</tr>
<tr>
<td><strong>Printer Language</strong></td>
<td>PCL5e, PCL6, PostScript level 2 Emulation</td>
</tr>
<tr>
<td><strong>Print Speed</strong></td>
<td></td>
</tr>
<tr>
<td>Digital Copier 35cpm</td>
<td>35 ppm (A4C, LetterC)</td>
</tr>
<tr>
<td>Digital Copier 25cpm</td>
<td>25 ppm (A4C, LetterC)</td>
</tr>
<tr>
<td><strong>CPU</strong></td>
<td>PowerPC 603e (100 MHz)</td>
</tr>
<tr>
<td><strong>ROM (program)</strong></td>
<td>8MB (Flash ROM), SIMM</td>
</tr>
<tr>
<td><strong>RAM</strong></td>
<td>16MB [8MB (on Board) + 8MB (DIMM)] Max. 72MB (max.: 168-pin DIMM 1 slot)</td>
</tr>
<tr>
<td><strong>Transfer Image Density</strong></td>
<td>600 × 600dpi</td>
</tr>
<tr>
<td><strong>Interface (on machine)</strong></td>
<td>Unique 8-bit parallel</td>
</tr>
<tr>
<td><strong>Interface (on host)</strong></td>
<td>Centronics Interface</td>
</tr>
<tr>
<td><strong>Networks</strong></td>
<td>10Base-T/2 (UTP/BNC) 10/100BaseT (UTP)</td>
</tr>
<tr>
<td><strong>Network Protocol</strong></td>
<td>TCP/IP, IPX/SPX</td>
</tr>
<tr>
<td><strong>Network Management</strong></td>
<td>To be managed from SNMP-compatible Web browser</td>
</tr>
<tr>
<td><strong>Power Requirements</strong></td>
<td>5V ± 5%, 6A max.</td>
</tr>
<tr>
<td><strong>Power Consumption</strong></td>
<td>30W max.</td>
</tr>
<tr>
<td><strong>Exterior Dimensions</strong></td>
<td>Width: 10-1/2” (264mm) × Depth: 3-1/4” (80mm) × Height: 8” (204mm)</td>
</tr>
<tr>
<td><strong>Weight</strong></td>
<td>4 lbs. (1.8 kg)</td>
</tr>
<tr>
<td><strong>Operating Environment</strong></td>
<td>Temperature: 50°F (10°C) to 95°F (35°C) Humidity: 15 to 85% RH (no condensation)</td>
</tr>
</tbody>
</table>
3. Specifications

Fonts:  PCL5e/PCL6 TrueType font, 10
        Agfa Intellit font, 35
        Adobe PostScript Level 2 Emulation Type 1 font, 35

Accessories:  Printer Driver (CD-ROM) for Pi3500 Printer Controller
              Engine interface cable 30 cm
              Short harness with ferrite core (except the U.S.A. and Canada)
              Ferrite core (except the U.S.A. and Canada)
              Tie band (except the U.S.A. and Canada)
              Windows User’s Manual
              Macintosh User’s Manual
              End User’s License Agreement
### 3. Specifications

#### Font

**TrueType, 10**
- Arial
- Arial Italic
- Arial Bold
- Arial Bold Italic
- Symbol

**Intelli font, 35**
- Albertus Medium
- Albertus Extra Bold
- Antique Olive
- Antique Olive Bold
- Antique Olive Italic
- Antique Olive Bold Italic
- Clarendon Condensed
- Coronet
- Courier
- Courier Bold
- Courier Bold Italic
- Garamond Antiqua
- Garamond Kursiv
- Garamond Kursiv Halbfett
- Garamond Halbfett
- Letter Gothic
- Letter Gothic Italic
- Letter Gothic Bold

**PostScript font, 35**
- ITC Avant Grade Gothic Book
- ITC Avant Grade Gothic Book Oblique
- ITC Avant Grade Gothic Demi
- ITC Avant Grade Gothic Demi Oblique
- ITC Bookman Demi
- ITC Bookman Demi Italic
- ITC Bookman Light
- ITC Bookman Light Italic
- Courier
- Courier Bold
- Courier Bold Oblique
- Courier Italic
- Palatino Bold Italic
### 3. Specifications

<table>
<thead>
<tr>
<th>Font Style</th>
<th>Font Style</th>
</tr>
</thead>
<tbody>
<tr>
<td>Palatino Italic</td>
<td>Times Italic</td>
</tr>
<tr>
<td>Palatino Roman</td>
<td>Times Roman</td>
</tr>
<tr>
<td>Times Bold</td>
<td>ITC Zapf Chancery medium Italic</td>
</tr>
<tr>
<td>Times Bold Italic</td>
<td>ITC Zapf Dingbats</td>
</tr>
<tr>
<td>Symbol</td>
<td></td>
</tr>
</tbody>
</table>
## Symbol Sets

<table>
<thead>
<tr>
<th>No.</th>
<th>Symbol Set Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Roman-8</td>
</tr>
<tr>
<td>2</td>
<td>ISO 8859/1 Latin 1</td>
</tr>
<tr>
<td>3</td>
<td>ISO 8859/2 Latin 2</td>
</tr>
<tr>
<td>4</td>
<td>ISO 8859/9 Latin 5</td>
</tr>
<tr>
<td>5</td>
<td>PC-8:Code Page 437</td>
</tr>
<tr>
<td>6</td>
<td>PC-8:Danish/Norwegian</td>
</tr>
<tr>
<td>7</td>
<td>PC-850 Multilingual</td>
</tr>
<tr>
<td>8</td>
<td>PC-852 Latin 2</td>
</tr>
<tr>
<td>9</td>
<td>PC-Turkish</td>
</tr>
<tr>
<td>10</td>
<td>Windows3.1 Latin 1</td>
</tr>
<tr>
<td>11</td>
<td>Windows3.1 Latin 2</td>
</tr>
<tr>
<td>12</td>
<td>Windows3.1 Latin 5</td>
</tr>
<tr>
<td>13</td>
<td>DESKTOP</td>
</tr>
<tr>
<td>14</td>
<td>PS Text</td>
</tr>
<tr>
<td>15</td>
<td>Ventura International</td>
</tr>
<tr>
<td>16</td>
<td>Ventura US</td>
</tr>
<tr>
<td>17</td>
<td>Microsoft Publishing</td>
</tr>
<tr>
<td>18</td>
<td>Math-8</td>
</tr>
<tr>
<td>19</td>
<td>PS Math</td>
</tr>
<tr>
<td>20</td>
<td>Ventura Math</td>
</tr>
<tr>
<td>21</td>
<td>Pi Font</td>
</tr>
<tr>
<td>22</td>
<td>Legal</td>
</tr>
<tr>
<td>23</td>
<td>ISO 4:United Kingdom</td>
</tr>
<tr>
<td>24</td>
<td>ISO 6:ASCII</td>
</tr>
<tr>
<td>25</td>
<td>ISO 11:Swedish</td>
</tr>
<tr>
<td>26</td>
<td>ISO 15:Italian</td>
</tr>
<tr>
<td>27</td>
<td>ISO 17:Spanish</td>
</tr>
<tr>
<td>28</td>
<td>ISO 21:German</td>
</tr>
<tr>
<td>29</td>
<td>ISO 60:Norwegian V1</td>
</tr>
<tr>
<td>30</td>
<td>ISO 69:French</td>
</tr>
<tr>
<td>31</td>
<td>Windows3.0 Latin 1</td>
</tr>
</tbody>
</table>
3. Specifications

Selectable Paper Sizes
Letter / Ledger / 11 × 14 / Legal / Invoice
Executive / A6 / A5 / A4 / A3 / B6 / B5 / B4
FLS1 / FLS2 / FLS3 / FLS4
1. Glossary

Glossary

**10BASE-T**
A network data transfer standard established by the IEEE. The network uses a twisted-pair cable carrying 10 megabits per second (10Mbps).

**10BASE-2**
A network data transfer standard established by the IEEE. Also called the thin Ethernet, the network uses a 5-mm-dia. unshielded coaxial cable carrying 10 megabits per second (Mbps).

**100BASE-T**
A network data transfer standard established by the IEEE. The network uses a twisted-pair cable carrying 100 megabits per second (Mbps).

**application**
A software program that performs a particular function, such as generating graphics or spreadsheets.

**click**
To press and release a mouse button quickly. Often used to select an object. SEE double-click.

**control panel**
A bank of indicators that show the current status of the printer. Panel buttons that are located on the control panel make it possible to perform a variety of different operations.

**default**
Settings that are preset in the absence of user-specified settings.

**dialog box**
A box that appears in order for the user to input information or settings required for the printer to operate.

**double-click**
Pressing a mouse button twice in quick succession while keeping the mouse in place. Often used to open a dialog or enable a function. SEE click.

**display**
A visual output device of a computer.
1. Glossary

**resolution**
The fineness of detail of the output print, expressed in the number of dots per inch (dpi, or dots per inch). Higher resolution produces text and graphics with greater sharpness and fineness of detail, but results in a greater amount of data involved.

**EtherTalk**
The AppleTalk protocol supporting Ethernet. It allows Macintosh users to use the Ethernet.

**font**
A complete set of characters in a given typeface and style. The size of characters is specified in points (1/72 inches). Typeface is the distinctive design of types, such as gothic, while style is an ornament, such as italic.

**halftone**
Gradations of tones expressed by means of varying densities of dots.

**hard disk drive**
A device that is contained in a computer and peripheral equipment and used to save data and files. In the printer controller, it is used to save fonts downloaded from the computer. Its data is retained even when the main power is turned OFF.

**icon**
A graphic image on the screen that represents an element.

**interface**
A standard that governs the ways for two different systems to exchange information. It specifies the format of data to be transmitted, communications protocols, and physical configurations for connection.

**IPX/SPX**
The communications protocols used by NetWare.

**landscape (paper orientation)**
A horizontal print orientation, in which printing is oriented so that the long edges of a sheet of paper are on top and bottom.

**local printer**
The printer that is directly connected to the computer being used. A printer connected to a network is called the remote printer.
1. Glossary

memory
The place in a computer where data can be stored and retrieved. The amount of data stored is expressed in bytes. Memory can either be RAM or ROM. Generally, the data stored in RAM is lost when power is turned OFF, while that in ROM is retained even when power is turned OFF, but cannot be rewritten.

Network Interface Card (NIC)
An optional card to which network interface can be added, used for connecting a printer to network environment.

offline
The state of the printer controller, in which it does not receive data or execute any processing.

online
The state of the printer controller, in which it is capable of receiving data and processing jobs.

operation system
A program or group of programs that control the functions of the computer and its peripheral devices such as the printer.

parallel interface
A type of standards that govern the ways for two different systems to exchange information, in which multiple bits are transmitted at one time. Because of that, synchronization is necessary, which makes the scheme not right for data transmission over a long distance. The most common parallel interface is Centronics.

port
A connector through which data is exchanged between a computer and peripheral equipment. The parallel port permits multiple-bit data to be transmitted at one time, commonly used in printers. The serial port is generally used to connect a modem or other device.

portrait (paper orientation)
A vertical print orientation, in which printing is oriented so that the short edges of a sheet of paper are on top and bottom.

PostScript font
A scalable outline font standard, widely adopted in the printing industry. By downloading PostScript fonts in a PostScript-compatible printer, it is possible to produce smoother letters than bit-mapped fonts can.
PostScript printer software
The program that is used on the computer to enable printing on PostScript printers.

printer driver
Software that enables controlling printer operations.

print job
A single batch of job for printing specified at one time from an application. It may be directly transmitted to the printer, or temporarily stored in a print queue.

print manager
An application that manages the print queue and print files.

resolution
See dpi.

SIMM
An acronym for Single In-line Memory Module.

TCP/IP
The standard data transfer protocol over the Internet. Data is transferred by breaking up data messages into packets, to which IP addresses are attached.

TrueType font
A soft font standard the system has. TrueType is a font technology that ensures that the printed output is identical to what you see on-screen. It is also scalable, capable of producing characters in varying sizes.

gray scale
The method of representing color data on a monochrome device by approximating the data with shades of gray (halftone).

paper
The medium on which the printer can print data. Varieties include OHP transparencies, labels, letterhead, and postcards, in addition to plain paper and recycled paper.
1. Glossary
Appendix C
### 1. INDEX

#### INDEX

**Numerics**
- 1in1 p.3-11
- 2in1 p.3-11
- 4in1 (Horiz.) p.3-11
- 4in1 (Vert.) p.3-11

**A**
- About... p.3-4
- About PCL5e and PCL6 p.1-5
- Access Code p.3-5
- Access Number p.3-13
- Add... p.3-34
- Adding a Cover to Each Copy Set p.4-31
- Administrative Functions p.1-5
- "Advanced" Property Sheet p.3-14
- Always use built-in printer fonts instead of TrueType fonts p.3-25
- Always use TrueType fonts p.3-25
- Angle p.3-20
- Assume header is downloaded and retained p.3-28

**B**
- Bitmap compression p.3-29
- Booklet p.3-11

**C**
- Coarse p.3-22
- Collate p.3-7
- Compress bitmap images p.3-29
- Configuration p.1-6
- Connecting the Printer Controller p.1-7
- Convenient Functions p.4-2
- Copies p.3-9
- Cover Mode p.3-17
- Ctrl+D p.3-29, p.3-30

**D**
- Darkness p.3-20
- Delete p.3-33
- "Details" Property Sheet p.2-14
- Device Option p.3-3
- "Device Option" Property Sheet p.3-3
## Appendix C

### 1. INDEX

<table>
<thead>
<tr>
<th>Feature/Property Sheet</th>
<th>p.2-11, p.2-25, p.2-37, p.2-47</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displaying a Property Sheet</td>
<td>p.2-11, p.2-25, p.2-37, p.2-47</td>
</tr>
<tr>
<td>Displaying a Property Sheet from an Application Menu</td>
<td>p.2-27, p.2-25, p.2-37, p.2-47</td>
</tr>
<tr>
<td>Displaying a Property Sheet from Print Manager</td>
<td>p.2-11, p.2-25</td>
</tr>
<tr>
<td>Displaying a Property Sheet from the Printer Folder</td>
<td>p.2-37, p.2-47</td>
</tr>
<tr>
<td>Distribution Number</td>
<td>p.3-14</td>
</tr>
<tr>
<td>Download as Bitmap</td>
<td>p.3-22</td>
</tr>
<tr>
<td>Download as Outline</td>
<td>p.3-22</td>
</tr>
<tr>
<td>Download header with each print job</td>
<td>p.3-28</td>
</tr>
<tr>
<td>Duplex Print</td>
<td>p.3-10</td>
</tr>
<tr>
<td>Duplex Unit</td>
<td>p.3-3</td>
</tr>
<tr>
<td>E</td>
<td>p.3-15</td>
</tr>
<tr>
<td>Edit</td>
<td>p.3-32</td>
</tr>
<tr>
<td>Edit Substitute Table...</td>
<td>p.3-28</td>
</tr>
<tr>
<td>Encapsulated, PostScript</td>
<td>p.5-9</td>
</tr>
<tr>
<td>Error List</td>
<td></td>
</tr>
<tr>
<td>F</td>
<td></td>
</tr>
<tr>
<td>Features of the Printer Controller</td>
<td>p.1-2</td>
</tr>
<tr>
<td>Fine</td>
<td>p.3-22</td>
</tr>
<tr>
<td>Finisher</td>
<td>p.3-4</td>
</tr>
<tr>
<td>Font</td>
<td>p.A-13</td>
</tr>
<tr>
<td>Font Substitute</td>
<td>p.3-32</td>
</tr>
<tr>
<td>Fonts</td>
<td>p.3-19</td>
</tr>
<tr>
<td>Form</td>
<td>p.3-11</td>
</tr>
<tr>
<td>Front Cover Paper Source</td>
<td>p.3-17</td>
</tr>
<tr>
<td>Function Combination Matrix</td>
<td>p.A-2</td>
</tr>
<tr>
<td>G</td>
<td></td>
</tr>
<tr>
<td>&quot;General&quot; Property Sheet</td>
<td>p.2-27, p.2-13</td>
</tr>
<tr>
<td>Glossary</td>
<td>p.B-2</td>
</tr>
<tr>
<td>Graphics Mode</td>
<td>p.3-21</td>
</tr>
<tr>
<td>&quot;Graphics&quot; Property Sheet</td>
<td>p.3-21</td>
</tr>
<tr>
<td>Group</td>
<td>p.3-7</td>
</tr>
<tr>
<td>H</td>
<td></td>
</tr>
<tr>
<td>Halftone</td>
<td>p.3-22, p.3-23, p.3-25, p.3-32</td>
</tr>
<tr>
<td>Hole Punch</td>
<td>p.3-8</td>
</tr>
</tbody>
</table>
## 1. INDEX

<table>
<thead>
<tr>
<th>Letter</th>
<th>Description</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>I</td>
<td>Image Density</td>
<td>p.3-14</td>
</tr>
<tr>
<td></td>
<td>Installation</td>
<td>p.2-3, p.2-17, p.2-33, p.2-40</td>
</tr>
<tr>
<td></td>
<td>Installed Drawer</td>
<td>p.3-3</td>
</tr>
<tr>
<td></td>
<td>Installing Various Printer Drivers</td>
<td>p.1-10</td>
</tr>
<tr>
<td></td>
<td>Interleaving Paper Source</td>
<td>p.3-16</td>
</tr>
<tr>
<td>J</td>
<td>Job timeout</td>
<td>p.3-29</td>
</tr>
<tr>
<td>L</td>
<td>Lock Job</td>
<td>p.3-15</td>
</tr>
<tr>
<td>M</td>
<td>Machine Preview</td>
<td>p.A-7</td>
</tr>
<tr>
<td></td>
<td>Mail Bin Name</td>
<td>p.3-4</td>
</tr>
<tr>
<td></td>
<td>Making General Settings Before Using the Printer</td>
<td>p.2-10, p.2-46</td>
</tr>
<tr>
<td></td>
<td>Mirror Image</td>
<td>p.3-25</td>
</tr>
<tr>
<td></td>
<td>Modify</td>
<td>p.3-34</td>
</tr>
<tr>
<td>N</td>
<td>Negative Image</td>
<td>p.3-25</td>
</tr>
<tr>
<td></td>
<td>No bitmap compression</td>
<td>p.3-29</td>
</tr>
<tr>
<td></td>
<td>Normal</td>
<td>p.3-32</td>
</tr>
<tr>
<td>O</td>
<td>OHP Interleaving</td>
<td>p.3-16</td>
</tr>
<tr>
<td></td>
<td>OHP Paper Source</td>
<td>p.3-16</td>
</tr>
<tr>
<td></td>
<td>Orientation</td>
<td>p.3-9</td>
</tr>
<tr>
<td>P</td>
<td>Paper</td>
<td>p.3-11</td>
</tr>
<tr>
<td></td>
<td>Paper Output</td>
<td>p.3-7</td>
</tr>
<tr>
<td></td>
<td>Paper Preview</td>
<td>p.A-4</td>
</tr>
<tr>
<td></td>
<td>&quot;Paper&quot; Property Sheet</td>
<td>p.3-5</td>
</tr>
<tr>
<td></td>
<td>Paper Size</td>
<td>p.3-6</td>
</tr>
<tr>
<td></td>
<td>Paper Source</td>
<td>p.3-6, p.3-17</td>
</tr>
<tr>
<td></td>
<td>Password</td>
<td>p.3-13</td>
</tr>
<tr>
<td></td>
<td>Poor Print Quality</td>
<td>p.5-8</td>
</tr>
<tr>
<td></td>
<td>&quot;Ports&quot; Property Sheet</td>
<td>p.2-28</td>
</tr>
</tbody>
</table>
### INDEX

1. **Position**   p.3-20
2. **PostScript**  p.3-28
3. **PostScript error information**  p.3-29
4. **PostScript Header**  p.3-28, p.3-30
5. **PostScript Output Format**  p.3-28, p.3-30
6. "**PostScript" Property Sheet"  p.3-28
7. **PostScript Timeout values**  p.3-29, p.3-32
8. **Print text as graphics image**  p.3-22
9. "**Printer Details" Dialog Box"  p.2-50
10. "**Printer Properties" Dialog Box"  p.2-49
11. **Printing in Reduced/Enlarged Size**  p.4-13
12. **Printing More Than One Copy at a Time**  p.4-3
13. **Printing on Both Sides of the Paper**  p.4-5
14. **Printing on OHP Transparencies**  p.4-29
15. **Printing Pages with a Distribution Number**  p.4-26
16. **Printing Pages with Watermarks**  p.3-2
17. **Property Sheets**  p.3-4
18. **Punch**  p.3-21, p.3-23, p.3-27, p.3-33
19. **R**  p.3-4, p.3-12, p.3-18, p.3-22, p.3-24, p.3-26, p.3-27, p.3-29, p.3-31, p.3-32
20. **Resolution**  p.3-33
21. **Restore**  p.3-4, p.3-12, p.3-18, p.3-22, p.3-24, p.3-26, p.3-27, p.3-29, p.3-31, p.3-32
22. **Restore Defaults**  p.3-25, p.3-27
23. **S**  p.3-29
24. "**Scheduling" Property Sheet"  p.2-29
25. "**Security" Dialog Box"  p.3-13
26. "**Security" Property Sheet"  p.2-31
27. **Selectable Paper Sizes**  p.2-16
28. **Send TrueType fonts to printer according to the font**  p.3-27
29. **Setting**  p.3-33
30. **Setting Preview**  p.3-4, p.3-12, p.3-18, p.3-22, p.3-24, p.3-26, p.3-27, p.3-29, p.3-31, p.3-32
31. **Special**  p.3-25, p.3-27
C-6

1. INDEX

Specifications p.A-11
Specifying Booklet Printing p.4-16
Specifying N-in-1 Printing p.4-10
Specifying the Exit Port p.4-8
Staple p.3-8
Starting Number p.3-14
Style p.3-20

T
Test Print p.2-9, p.2-23
Text p.3-15, p.3-19
Title p.3-33
TrueType Fonts p.3-22, p.3-23, p.3-25, p.3-27
Typical Test Print Outputs p.1-9

U
Unable to Make Correct Settings / Unable to Print Exactly as Set p.5-5
Unable to Print p.5-2
UnCollated p.3-7
Use Printer’s settings p.3-25
Use Raster Graphics p.3-21
Use settings below p.3-25
Use Vector Graphics p.3-21
User Name p.3-4
Using the Copy Track Function p.4-18
Using the Lock Job Function p.4-33
Using the Settings Function p.4-43

V
Various Printing Functions p.1-2

W
Wait timeout p.3-29
Watermark p.3-15
"Watermark" Dialog Box p.3-19
with Back Cover p.3-17
with Image p.3-17

Z
Zoom p.3-11